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[ Usage and Safety Precautions

)

Safety Precautions

In this operation manual, symbols are used to
highlight warnings and cautions that you must
read to prevent accidents. The meanings of
these symbols are as follows.

Something that could cause

- serious injury or death
Warning

Something that could cause injury

or damage to the equipment
Caution

Other symbols used

o An action that is mandatory

® An action that is prohibited

| AWarning

Operation using an AC adapter
0 Never use any AC adapter other than a
ZOOM AD-19.

Operation with external DC power supply

@ Use a 9V-16V external DC power supply.

a Carefully study the warning indications of
the external DC power supply before use.

Operation with batteries
Use 8 commercially-available 1.5V AA bat-
teries (alkaline dry cell batteries, nickel
metal hydride batteries or lithium dry cell
batteries).

0 Carefully study the warning indications of
the batteries before use.
Always keep the battery cover closed
during use.

Alterations

® Do not open the case or modify the prod-
uct.

| A\ Caution

Product handling
Do not drop, bump or apply excessive
force to the unit.
Be careful not to allow foreign objects or
liquids to enter the unit.

Operating environment

© Do not use in extremely high or low tem-
peratures.
Do not use near heaters, stoves and other
heat sources.
Do not use in very high humidity or where
it could be splashed by water.
Do not use in places with frequent vibra-
tions.
Do not use in places with much dust or
sand.

AC adapter handling
When disconnecting the power plug from
an outlet, always pull on the plug itself.

0 Disconnect the power plug from the outlet
when the unit will not be used for
extended periods and whenever there is
lightning.

Battery handling

a Install batteries with the correct +/— orien-
tations.

“ Use the specified batteries. Do not use
new and old batteries together. Do not use
batteries of different brands or types
together.

“ Remove the batteries when the unit will
not be used for extended periods.
If a leak occurs, thoroughly wipe the bat-
tery case and battery terminals to remove
the leaked fluid.

Danger of explosion if battery is incorrectly
replaced. Replace only with the same or
equivalent type.

A warning that batteries (battery pack or
batteries installed) shall not be exposed to
excessive heat such as sunshine, fire or
the like.

Mic handling

a Always turn the power switch OFF before
connecting a mic. Do not apply unneces-
sary force when connecting a mic.
Attach the protective cap when no mic is
connected for extended periods.

Connection cables and input/output jacks

0 Always turn the power OFF for all equip-
ment before connecting any cables.
Always disconnect all connection cables
and the AC adapter before moving the unit.

Volume
Do not use at a loud volume for extended
periods.

Usage Precautions

Interference with other electrical equipment
In consideration of safety, the = BB has been
designed to minimize its emission of electro-
magnetic waves and to suppress interference
from external electromagnetic waves. How-
ever, equipment that is very susceptible to
interference or that emits powerful electro-
magnetic waves could result in interference if
placed nearby. If this occurs, place the 8
and the other device farther apart.

With any type of electronic device that uses
digital control, including the B8, clectio-
magnetic interference could cause malfunc-
tion, corrupt or destroy data and result in other
unexpected trouble. Always use caution.

Cleaning

Use a soft cloth to clean the exterior of the unit
if it becomes dirty. If necessary, use a damp
cloth that has been wrung out well to wipe it.
Never use abrasive cleansers, wax or solvents
such as alcohol, benzene or paint thinner.

Breakdown and malfunction

If the unit becomes broken or malfunctions,
immediately disconnect the AC adapter or DC
power supply, turn the power off and discon-
nect other cables. Contact the store where you
bought the unit or ZOOM service center with
the following information:  product model,
serial number and specific symptoms of break-

down or malfunction, along with your name,
address and telephone number.

Copyrights

© Windows® and Windows® 7 are trademarks
or registered trademarks of Microsoft® Corpo-
ration.

© Macintosh, Mac OS and iPad are trademarks
or registered trademarks of Apple Inc.

o The SD, SDHC and SDXC logos are trade-
marks. MPEG Layer-3 audio compression tech-
nology is licensed from Fraunhofer IIS and Sis-
vel S.p.A.

o Bluetooth and the Bluetooth logo are regis-
tered trademarks of Bluetooth SIG, Inc. and are
used under license by ZOOM CORPORATION.
o Other product names, registered trademarks
and company names in this document are the
property of their respective companies.

Note: All trademarks and registered trade-
marks in this document are for identifi-
cation purposes only and are not
intended to infringe on the copyrights of
their respective owners.

Recording from copyrighted sources, including
CDs, records, tapes, live performances, video
works and broadcasts, without permission of
the copyright holder for any purpose other than
personal use is prohibited by law.

ZOOM CORPORATION will not assume any
responsibility related to infringements of copy-
rights.

Note about the Auto Power Off function

The power will automatically turn off if unused
for 10 hours. If you want the power to instead
remain on, see "Disabling the Automatic Power
Saving function” on P20 and turn the function
off.



[ Introduction

Thank you very much for purchasing a ZOOM I~ 8 Multitrack Field
Recorder. The I B8 has the following features:

¢ 8 analog input channels with super high-quality preamps
The 8 lockable XLR/TRS combo jacks provide high-quality analog
inputs with EIN of =127 dBu or less, +75dB maximum input gain and
support for +4dB input.

¢ PCM recording at up to 192kHz/24-bit resolution

¢ Recording of up to 10 tracks simultaneously
Inputs 1-8 and a stereo mix (left and right) can be recorded at the
same time (8 tracks when the sampling rate is 192 kHz).

¢ Dual channel recording of separate files at lower levels
simultaneously with ordinary recording (Inputs 1-4)

Using dual channel recording at a lower input level, you can create
backup recordings to use when unexpected loud noise causes regu-
lar recordings to distort, for example.

* Newly redesigned limiters for overload protection

With 10 dB of headroom, this limiter prevents distortion even more
than ordinary ones. The threshold can also be set to keep the signal
below that level.

*Time code with pinpoint accuracy

The IF 8 utilizes a high-precision oscillator that generates time-
code with accuracy of 0.2ppm, ensuring rock-solid stability when
syncing audio and video.

e Outputs include a stereo headphone jack with a powerful
100mW amp as well as MAIN OUT 1/2 and SUB OUT 1/2
jacks

This allows you to send the audio signal to a video camera or other
device while monitoring with headphones.

e Built-in digital mixer with flexible signal routing
Prefader and postfader signals from inputs 1-8 can be freely routed
to any outputs.

* Phantom power (+24V/+48V) can be supplied
This can be turned on/off for each input separately.

*Three possible power sources —batteries, an AC adapter and
an external DC power supply

In addition to AA batteries and an AC adapter, a 9-16V external DC
power supply can also be used.

¢ Double SDXC card slots

Simultaneous recording on 2 SD cards is possible, and support for
SDXC cards up to 512 GB enables long-duration recording. In addi-
tion, the I B3 can be used as a card reader by connecting to a
computer using USB.

¢ USB audio interface capabilities with up to 8 ins and 4 outs
The = 83 can be used not only as a 2-in/2-out audio interface, but
also as an 8-in/4-out audio interface (driver required for Windows).

e Other useful features

Other convenient functions include a built-in slate mic for voice
memos and a variable frequency slate tone generator to confirm lev-
els.There are also input and output delays and pre-recording of up to
6 seconds.

¢ ZOOM mic capsules can be connected
Use any ZOOM mic capsule instead of inputs 1/2.

Please read this manual carefully to fully understand the functions of
the I B3 so that you can make the most of it for many years. After
reading this manual, please keep it with the warranty in a safe place.

uononpoJ|
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[ Names of parts

DC IN connector

Front
Select Slate Track Track Input volume
Display encoder switch indicator key knob
i
L T )
. - LED level
(o) meter
@ % PFL key
] < Fo ][} Dy, f.,
n.< ) | e | | || | | >/u | | l e ! _/j Slate mic
¢ |.I|_u_u _] — o— :bi
MENU  Headphone Search Stop Search Play/pause Record POWER
key volume  backward key forward key key switch
key key
Back

o

Nyd
=T=
=i
o6 i £
12Vt-Tct) _:l:_
D our
‘ T

Timecode IN/OUT
connectors

Battery slot

MIC IN
connector

LED level meter

Green Orange Red

DDDDII

-48 -30 -18 -12 -6
(dBFS)



EXTDCIN usB
connector port

Left side

SD card
slots

Right side
Headphone MAIN OUT 1/2
jack jacks

Lock release SUB OUT 1/2
button jack
0 ==

E I,
f AP AP 0

SUB OUT 1/2

‘. 7~ \\ MAIN ouT
) )

J e ~ (PUSH) 7 — (PUSH)
N '\

Inputs 1-4
EXTDCIN Inputs 1-8
3:NC ( ) 2:NC J
B 2 1: GND
2: HOT
DC 9-16V 3 COLD
HIROSE 4-pin XLR TRS

TIP: HOT

RING: COLD

SLEEVE: GND

Inputs 5-8

MAIN OUT

3 2: HOT
3:COLD

TA-3

sped Jo saweN
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[Connecting mics/other devices to Inputs 1-8

The I B3 can record a total of 10 tracks simultaneously: 8 individual tracks with signals coming from Inputs 1-8 and a stereo

mix of these inputs on left and right tracks.

You can connect mics and the outputs of line-level devices such as keyboards, mixers, or instruments with active electronics
to Inputs 1-8 and record them to tracks 1-8. Alternatively, Inputs 1 and 2 can instead receive input from a ZOOM mic capsule

connected to the I B3 MIC IN connector.

Connecting mics

Connect dynamic and condenser mics with XLR plugs to
Inputs 1-8.

Phantom power (+24V/+48V) can be supplied to condenser
mics. (— P87)

(XLR cable) (XLR cable)

NOTE
When disconnecting a mic, gently pull on the XLR plug while simul-

taneously pushing the connector lock release button.

Connecting line level equipment

Connect the TRS plugs of keyboards and mixers directly to
Inputs 1-8.
Direct input of passive guitars and basses is not supported.

Connect these instruments through a mixer or effects device.
s

©8
© 8
°
8
°
8
°
8
°
8
°
8
°
8

00000
00000
00000 | [®
00000 | @
00000 | @
00000 | [®
00000 | [®
00000 | [©
[e]e]e)

[ =0 [ 00000

[ =0
[ =0
0 <=0
0o
<=0
[ =0
[ =0
0 <=0

(TRS cable) (TRS cable)



)

Connecting mic capsules

A ZOOM mic capsule can be connected to the MIC IN connec-

tor on the back of the I B3.

e The mic capsule input is assigned to tracks 1/2.

e When a mic capsule is connected, Inputs 1/2 cannot be used.

Connecting and disconnecting mic capsules

1 = Remove the protective caps from the 8 and the

mic capsule or extension cable.

2 = While pressing the side buttons on the mic capsule or

extension cable, connect it to the main unit, inserting

=

mp ) <=

it completely.

3- To disconnect the mic capsule or extension cable, pull
it away from the main unit while simultaneously

pressing the buttons on its sides.

* Do not use too much force when disconnecting. Doing so could
damage the mic capsule, extension cable or main unit.
e Reattach the protective cap when a mic capsule is not connected.

Stereo input

By enabling the stereo link for tracks 1/2, 3/4, 5/6 or 7/8, the
corresponding Inputs (1/2, 3/4, 5/6 or 7/8) can be handled as a
stereo pair. (— P.26)

When linked, Input 1, 3, 5 or 7 becomes the left channel and
Input 2, 4, 6 or 8 becomes the right channel.

g1 sindu| 01 s8d1A8p J8Y10/solw Buiosuuo)
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[Connecting mics/other devices to Inputs 1-8 (continued) )

Connection examples

The IF B3 allows you to record in a variety of situations, such as the following.

While filming Concert recording

e Input 1: gun mic for main subject sound (XLR connection) e Inputs 1-4: mics for stage performance (XLR connections)

e Inputs 2-5: wireless lavalier mics for performers (TRS e Inputs 5-6: line-level PA mixer outputs (TRS connections)
connections) ¢ |nputs 7-8: mics for audience sound (XLR connections)

e Inputs 6-7: mics for ambient sound (XLR connections)

Wireless lavalier mics

50 06 99 60 90 66 50 00
Gun mic ©eoe0e000@

————————
00000000 [}
00000000 [}
00000000 00
00000000 00
O0O0O0O0OO0O00 00
Vocal mic, etc. I } Socossss e
( 2 J(§bEbbE

rV
Cooooooo o
PA mixer
Lavalier receivers Ambient /
RIRENRIDENRIDENRID) ’:ﬂg”
ﬁ ﬁ ﬁ ﬁ Audience mics
jmZm] Jaral \

il GD@ @ =5 = J

i) J
M Ot oot
— 0 D DD || | e
—a O EoEccacy 5y | Ee—
C )




( LCD display )

Home Screen Power type and remaining power
P Status icon Recording/playback timecode DC: AC adapter @ Full
= Mixer Py EXT: external DC
D Stopped Paused Frame rate power supply
- INT: internal timecode enabled AA: batteries
. Recording Playing EXT: external input timecode enabled
Counter

(playback/elapsed recording time)
Track number

Red: input enabled

Green: playback track enabled 000 00 00 RHIg=H S

Grey: input disabled [][] ].2 32 ].].
Limiter status
Grey: disabled

Red: enabled

Yellow: functioning Stereo-linked

inputs
Phantom power status
Lit: enabled
Unlit: disabled Fader
Pan

Level meters

Recording/playback take name ” .
Clip indicators

Press[=_Jwhen stopped to show the
name of the next track to be recorded.

L/R tracks

Limiter indicators
Yellow: limiter functioning

WAV 48.000
MP3 220kbps

Aejdsip @07

Playback card Recording/playback  Recording/playback tracks
Green: used for playback file format and Red: recording tracks When recording: remaining recordable time
Grey: no card sampling rate Green: playback tracks When playing: remaining playback time
(by card) Grey: disabled tracks (by card)
(by card)
HINT

e Stereo-linked tracks are shown together, for example, "7/8".
e When the Home Screen is not displayed, press and hold to
return to the Home Screen.




Aeldsip @01

[ LCD display (continued)

= Level meters
Recording/playback

Status icon Counter Frame rate timecode
Power type and

remaining power

INT 29.97D
" " r " r
00082JOJ F Clip indicators
Limiter
indicators
Tracks 1-8
L/R tracks Level
meters
MAIN OUT 1/2,
SUB OUT 1/2
tracks
-12 -G
Recording/playback BBl : wav 48.000 Sem30
take name 502 : MP3 320kbrs 013053
Playback  Recording/playback When recording: remaining recordable time
card file format and When playing: remaining playback time
sampling rate (by card)
(by card)

=\
Turn @ to switch between showing the mixer (Tracks 1-8, MAIN
OUT 1/2, SUB OUT 1/2) and level meters (Views 1-4 can be set —
P.146) on the display.




Character input screen

Text box

Pro ject001]
[1]2]3f4]s]6]7]8]9]0]
(A]BJCIDIE]FIGIH]T]I]

Keyboard

KJLIMINTOIPTQIRIS]T)

WixIv]z]_[-] e
[ abc | Enter
REW/FF </ > MENU - Cancel
Press

Instructions

Edit |

Pro ject001] 10740

| Project00l] |
8806000080
8000000006

Automatic
input keys

(Project) | (Scene) | Del
[ABC |
REW/FF:¢-/ >

MENU : Cancel

e The following characters can be used in project names:
(space)!#%$'()+,-0123456789;=@ ABCDEFGHIJKLMNOPQRSTU

VWXYZ[]*_"abcdefghijklmnopqgrstuvwxyz{}~

DC
Pro ject001| 10/40

[1]2]3]4]5]6]7]8]9]0)

Edit

Number of characters input/
Maximum number of characters

>Walolcldlelflelnlili
K] (plalrls]t)

Press
_1-] Del
|£| Enter
Press REW/FF4-/ > MENU : Cancel

= Editing operations
Move cursor in box: and

Turn @
Press @

Move cursor to “Enter” and press @

Select character:
Confirm character:
Complete editing:

Cancel editing: Press

= Automatic input keys
(Date): Automatically inputs the date. Example: 150210
(Time): Automatically inputs the time. Example: 180950
(Project): Automatically inputs “Project***” in the field.
(Scene): Automatically inputs the scene name.

Aejdsip 01
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[ Supplying power

Using AA batteries
9 4. Install the batteries.

1 = Turn the power off and then loosen the screw in the

battery cover to open it.

2 = Remove the battery case from the battery slot.

Jamod BuiAjddng

5 = Replace the battery case cover.

6. Load the battery case.

Load the case so that the side with the protruding rail is up.

7. Close the battery cover and tighten the screw.

NOTE

e Be careful because the battery case could become loose unex-
pectedly if the cover screw is not tightened firmly.

3- Open the battery case cover. e Use only one type of batteries (alkaline, NiMH or lithium) at a
time.

e After loading batteries, set "Power Source" to the correct type of
battery. (— P22)

e If the remaining battery power indicator turns red, turn the power
off immediately and install new batteries.

14



Using an AC adapter

1 = Connect the dedicated AC adapter to the DC IN

connector.

2 = Plug the dedicated AC adapter into an outlet.

Using an external DC power supply

1 = Connect the external DC power supply equipment to

the EXT DC IN (Hirose) connector.

Connect a 9-16V direct-current power supply.

2 = If there is an adapter, plug the adapter into an outlet.

When connecting an external DC power supply, be sure to make

the power supply settings. (— P.21)

J1amod BuiAjddng
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[Loading an SD card

1 = Turn the power off and then open the SD card slot

2 = Insert the SD card into the SD CARD 1 or 2 slot.

To eject an SD card:
Push the card further into the slot until it clicks and then
pull it out.

NOTE

Always turn the power off before inserting or removing an SD
card. Inserting or removing a card while the power is on could
result in data loss.

When inserting an SD card, be sure to insert the correct end with
the top side up as shown.

If an SD card is not loaded, recording and playback will not be
possible.

To format an SD card, see P. 159.

DUAL
CHANNEL
RECORDING

XLRMIC
TRSLINE
(20d8)




[Turning the power on and off

Turning the power on

POWER
1. Pressand hold (D briefly.

POWER

The (__J) LED will light.

000000 E I]I]I]I]I]I]

k: :-w 15.", %
POWER
HOECICE
I ]

| N E—

NOTE

® The first time you turn the power on after purchase, you must
set the date/time (— P. 18).You can also change this setting later.

e If “No Card!” appears on the display, confirm that an SD card is
inserted properly.

e |f“Card Protected!” appears on the display, the SD card write-pro-
tection is enabled. Slide the lock switch on the SD card to disable
write-protection.

e If “Invalid Card!” appears on the display, the card is not format-
ted correctly. Format the card or use a different card.To format an
SD card, see P. 159.

Turning the power off

POWER
1. Pressand hold (] briefly.

Keep pressing it until the ZOOM logo appears on the LCD.

The F B8 will automatically turn off if
it is unused for 10 hours.
To keep the power on continuously until powered off, see "Dis-

abling the Automatic Power Saving function" on P20 and set Auto

Power OFF to Off.

10 pue uo Jamod sy} Buiuing
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[Setting the date and time (Date/Time (RTC))

The date and time set on the - BB are used when recording files, for example.

You can also set the date format (order of year, month and day).

1 = Press .

=

2 (|
= Use @ to select SYSTEM, o
QUTPUT »
REC »

and press . [RLEY D |
TIMECODE »
SLATE >

SYSTEM
MENU : Return

=)
3 . SYSTEM
= Use @ to select Date/Time
Power Source »
Auto Power OFf On
( RTC ) ,a nd press @ " Home Timecode Display Size ~ Small

Level Meter >
LED Brightness 100

MENU : Return

The first time you turn the FB on after purchasing it, you

must set the date/time.

» Continue to one of the following procedures.

Setting the date and time .............
Setting the date format.................

Setting the date and time

=
4- Use @ to select Set

Date/Time, and press @

5 = Change the setting.

= Changing settings

Move cursor or change value:

P
Turn @

Select item to change: Press

.................................... P18
.................................... P19

Date/Time (RTC) =)

bC

Date Format yy/mm/dd

Set Date/Time 4

MENU : Return

Set Date/Time

Year Month Day
TN5; 04 0l (WED)

13 : 00 : 00

MENU : Cancel




—x
6. Use @ to select Enter,

and press @

This completes setting the date
and time.

Setting the date format

—x
4. Use @ to select Date

Format, and press @

Set Date/Time

Year Month Day
2015 04 01 (WED)

13 ¢ 00 : 00

[ Enter \

MENU : Cancel

=
5- Use @ to select the

format, and press @

Date/Time (RTC) -

=

Date Format yy/mm/dd

Set Date/Time >

MENU : Return

Date Format

mm/dd/yy
dd/mm/yy

« yy/mm/dd

MENU : Return

Setting value Explanation
mm/dd/yy Month, day, year order
dd/mm/yy Day, month, year order
yy/mm/dd Year, month, day order

((014) awi]/e18Q) BWI pUE d)Ep By} Bumes
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[ Disabling the Automatic Power Saving function (Auto Power Off) ]

The power will automatically turn off if the I~ B8l is unused for 10 hours.
If you want the power to stay on continuously until powered off, disable the Automatic Power Saving function.

=
1 = Press - 4- Use @ to select 0ff, uto Power OFF 45

On
= and press @
2. Usel ) toselect SYSTEN, =

OUTPUT

>
REC >
and press . [FLERY D |
TIMECODE >
>

SLATE

SYSTEM 4

MENU : Return

MENU : Return

=)

3. Use @ to select Auto Power SYSIEM =
Date/Time (RTC) >
Power Source >
Of f and press @ i Auto Power OFf On
Home Timecode Display Size Small

Level Meter >
LED Brightness 100

MENU : Return




[ Setting the power supply used (Power Source) ]

Set the external DC power supply shutdown voltage, nominal voltage and type of batteries so that the remaining power supply

charge can be shown accurately.

On this menu page, you can also check the voltage of each power supply and the remaining battery capacity.

1. Press .
=)
2. Use () toselect SYSTEN, :

QUTPUT

REC
and press . IFLESY |
TIMECODE

SLATE

SYSTEM 4

MENU : Return

)

3. Use @ to select Power

Source, and press @

SYSTEM

Date/Time (RTC)
Power Source
Auto Power OFf

Home Timecode Display Size Stmall
Level Meter »
LED Brightness 100

MENU : Return

P Continue to one of the following procedures.

Setting DC power supply (Ext DC) shutdown voltage . . . P21
Setting DC power supply (Ext DC) nominal voltage. . ... P22
Setting the AA battery type (IntAA). . ................ P22

Setting DC power supply (Ext DC) shutdown voltage
When an external DC power supply is being used, if the voltage
drops below the value set here, the = B3 will automatically stop
recording and turn off.

If AA batteries (Int AA) are installed, however, the power supply will
switch to INT AA and operation will continue.

—x
4- Use @ to select Shutdown

Voltage, and press .

Power Source

DCIN  Wi2EN
ExtDC ]
Shutdown Voltage 130V

Nominal Voltage 148V
Intas ]
Battery Type Alkaline

MENU : Return|

HINT

e The shutdown voltage is the voltage when the external DC power
supply runs out and can no longer supply power.

e See the manual for the external DC power supply for the shut-
down voltage value.

Shutdown Voltage

=
5- Use @ to select the
voltage, and press .

130V s

MENU : Return

(994n0g 1amod) pasn Ajddns Jamod syl Bumeg
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[ Setting the power supply used (Power Source) (continued)

Setting DC power supply (Ext DC) nominal voltage
e
4. Use @ to select Nominal

Voltage, and press @

Power Source

DCIN s
Extbc ]
Shutdown Voltage 130v

Nominal Voltage 14.8v
Intaa ]
Battery Type Alkaline

MENU : Return

Nominal Voltage

e
5- Use @ to select the

voltage, and press @

MENU : Return

HINT

The nominal voltage is the voltage of the external DC power supply

under normal conditions.This value should be indicated on the out-

side of the external DC power supply.

Setting the AA battery type (Int AA)
=)
4. Use @ to select Battery

Type, and press @

Power Source

DCIN 2w
ExtDC ]
Shutdown Voltage 130V
Nominal Voltage 148V
Intas ]
Battery Type Alkaline

MENU : Return

Battery Type —

5 A
. Use@““'ec”hetype'

Ni-MH
and press . Lithium

MENU : Return

e When multiple power supplies are connected, they will be used

in the following order of precedence.
1. Dedicated AC adapter (DC IN)

2. External DC power supply (Ext DC)
3. AA batteries in unit (Int AA)

e The voltages of each power supply are shown on the display.




[ Recording process

Recording with the IFF BB follows the process shown below.
The data created for each recording occurrence is called a "take".

Play back Check take
Turn power Prepare before Record ) .
on (— P.17) e (— P.28) and check information
: : (— P.50) (— P.61)

e :ooooo e
[ ] [} (]
e ° N
e Connect mics, instruments, : ® Press @to start and OPressto start playback * Check and edit
audiovisual equipment and : @to stop recording. and@or @to stop it. metadata.
other devices to Inputs 1-8. H ® You can also set marks. * Marks, for example, can also
(—P.8) ) o | ePress_e Jtostart be set. (— P.152)
e Connect a mic capsule to the s recording a new track.
MIC IN connector. (— P.9) ° o Press|
H
[
§ . J
[
[
[
°
°
e N
1. Set the SD card and file format 2. Select the recording tracks 3. Make recording settings 4. Adjust the input levels
for recording. (— P.24) (— P.26) * Make other settings, including for the (— P.27)
e Set the recording file format for each e Use track keys to select. following functions: .U . }
: se to adjust each input.
SD card separately. The indicators for selected tracks light - dual channel recording (— P.32) s l. P
red and you will be able to monitor - Pre recording (— P.34) * The side mic level can also be
input sounds. - high pass filter (— P.80) adjusted when using a mid-side mic
e Press two track keys simultaneously - limiter (— P.81) capsule.
to link them as a stereo track.
\ Y,

=)
(0]
Q
o
=
=
=]
«©

ss9004d Buipioday
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[ Enabling recording on SD cards and setting file formats

HINT

example.

and right tracks.

® Recording the same content to two cards is possible by using
the same settings for both card slots. This function can be used
to create a backup in case the sound skips on one card, for

e You can also record tracks 1-8 unmixed on one SD card while
recording all tracks mixed together as MP3 or WAV data with left

1 = Press .
=
2 = Use @ to select REC,

and press @

sjewJoy 3|1} Buimes pue spied Qg uo Buiplodal Bujjgeuy

=)
3. Use @ to select

Rec to SDI1 orRec to SD2,

and press @

24

MENU

FINDER

META DATA (for Next Take)
INPUT

OUTPUT

REC

PLAY

bC

Rec to SD1 Tr1-8 Poly?

Rec to SD2 Tr1-8 (Poly)
Sample Rate 48kHz
WAV Bit Depth 24
MP3 Bit Rate 320kbps
Dual Channel Rec »

MENU : Return

The recording file format can be set independently for SD CARD slots 1 and 2.

type, and press @

Rec to SD1 L

bC

)
4 . None
= Use to select the file

Trackl-8 (Mono/Stereo WAV)

Trackl-8 + L/R (Poly WAY)
Trackl-8 + L/R (Mono/Stereo WAV)
L/R (Stereo WAY)

Setting value Tracks recorded | Explanation
None - Nothing is recorded on the SD card.
Track1-8 A single (multitrack) file is created that
contains audio for multiple tracks.
(Poly WAV) Selected tracks - — P
1-8 A single mono file is created for
Track1-8 h « al
(Mono/Stereo WAV) each mono tracl and a single stereo
file is created for each stereo track.
Track1-8 + L/IR A single (multitrack) file is created that
contains audio for multiple tracks.
(Poly WAV) All selected - : ud 'r .u et
Track1-8 + LR tracks A single mono file is cregted for
M /St WAV) each mono track and a single stereo
ono/otereo file is created for each stereo track.
L/R (Stereo WAV) A stereo file is created based on the
L/R tracks ; - )
L/R (Stereo MP3) mix created by the internal mixer.




NOTE

e When recording with a Mono/Stereo WAV setting, the audio files
are saved in a take folder that is created. (— P.37)

e When recording to 2 SD cards simultaneously, files will be saved
in take folders with the same name on both cards. Folders will be
created automatically if they do not already exist.

e |If recording should stop on one SD card because, for example, it
runs out of space, recording will continue on the other SD card.
At such times, do not remove the card that has stopped recording
from the slot. Doing so could damage the card or data.

Buipiooay
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[ Selecting inputs and adjusting levels

You can select which of Inputs 1-8 to use. Inputs will be recorded on tracks with the same numbers. For example, Input 1 will
be recorded on track 1 and Input 2 will be recorded on track 2.

s|aAa| Bunsn(pe pue syndu| Bulos|ag
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Selecting inputs

1 = Make the track indicator light by pressing the track

key for the number of the input to record.

1] 220 ] u‘q_qup'u @ng_qqgu ug_qqgu

(ﬁm » PFL 0 75: -‘m ‘10

I—Iouuuuu I’—Iunnnnu [—quunnu [—I"""Mﬁ m

The background color of the track number on the LCD also
changes at this time.

Track number
background color

Lit red Red
Unlit

Track indicator Explanation

The input is enabled.

Gray The input is disabled.

The signals from the inputs selected this way will also be sent to
the L/R tracks.

Linking inputs as a stereo pair

1 = While pressing track key 1, press track key 2.

000000 000000 000000 000000
drxdyxdh)=xq));
W — 1o \JW PFL : l] 75‘ -10 1.';

nﬂﬂﬂﬂﬂﬂ ‘n IJU(I[IU[I HUDUUUH nﬂiﬁglffl

Tracks 1 and 2 will be linked as a stereo track (stereo link).
Repeat the same procedure to disable the stereo link.

HINT

e The 3/4, 5/6 and 7/8 track pairs can also be stereo-linked in the
same way.

e When a mic capsule that allows independent L and R input selec-
tion is connected, stereo-linking can also be enabled and dis-

abled for those tracks.




Adjusting input levels

I
nuuuuu ounuuu 000000 onnuuu
NOTE

When a mic capsule is connected, for Inputs 1/2 is disabled.

Use the level control on the mic capgulg to adjust its input volume.

HINT
e Inputs connected with XLR plugs can be set from +10 to +75 dB,

and inputs connected with TRS plugs can be set from -10 to +55
dB.

e |If the sound distorts even when you lower the input level, try
changing mic positions and adjusting the output levels of con-
nected devices.

e Using the limiter (— P.81)

e Using the high pass filter (— P.80)

s|eas| Bunsnlpe pue sinduj Buiios|ag
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[ Recording

@ 000000 @ 000000
o >

r—-sy]

CEOE

1 = Press .

This starts recording.

HINT

If the timecode function is enabled, recording will start from frame
00 (00 or 02 when using drop frame) and files will always end
exactly on a second. This makes synchronization easy when editing
later.

2 = Press to start a new take when recording.

This will end the current take and start a new take while
continuing to record without interruption.

Pressing during recording is only possible after recording for
at least a second.

3. Press to pause.

e When pausing, pausing will occur at a whole second increment.

e When recording is paused, a mark is added at that point.
Press to resume recording.

e A maximum of 99 marks can be added to a take.

HINT

e During playback, you can press and [=] to jump to points
where marks have been added.
® You can also add marks without pausing. (= P. 152)

4. Press to stop.

e If the maximum file size is exceeded during recording (— P.35),
recording will continue in a new take with a number that is one
higher. No gap in sound will occur between the two takes when
this happens.

e When recording on 2 SD cards simultaneously, if recording
should stop on one because it runs out of space, recording will
continue on the other SD card without interruption.

HINT

e Files are automatically saved at regular intervals during record-
ing. Even if the power is interrupted or another unexpected prob-
lem occurs during recording, an affected file can be restored to
normal by playing it with the = &3.

® Press and hold when the HOME screen is open to check the
name that will be given to the next take recorded.




[Setting the sampling rate (Sample Rate)

You can set the sampling rate used to record files.

1.

2.

Press .

=
Use @ to select REC,

and press @

—=x
Use @ to select Sample

Rate, and press @

=\
Use @ to select the

sampling rate, and

press @

Setting value

Explanation

44.1kHz, 48kHz,
88.2kHz, 96kHz, 192kHz

These are standard sampling rates.

MENU

Select this when recording video at 23.976 frames

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

47.952kHz per second if you want to edit at 24 frames per
second later.
Select this when recording video at 24 frames per
48.048kHz second if you want to edit at NTSC 29.97 or 23.98

HD later.

REC
PLAY

e

Rec to SD1 Tr1-8 cpoly>

47.952kHz (F),
48.048kHz (F)

These function the same as the two above, but the
<FILE_SAMPLE_RATE> sampling rate metadata
will be recorded as 48kHz.

This enables playback and editing with devices
and software that do not support 47.952kHz and
48.048kHz WAV files. Playback, however, will occur
at the +0.1% speed at which the file was recorded.

Rec to SD2 Tr1-8 (Poly>

Sample Rate 48kHz

WAV Bit Depth 24
MP3 Bit Rate 320kbps
Dual Channel Rec »

MENU : Return|

NOTE

* When the recording file format is MP3, only 44.1kHz and 48kHz

can be selected.

e When 192kHz is selected, L/R tracks will not be recorded. The

Input Delay and Output Delay are also disabled.

Sample Rate
44.1kHz
47952kHz
47952kHz (F)

v 48kHz
48.048kHz
48048kHz (F)

MENU : Return

(e1ey o|dweg) a1e4 Buldwes ayl Bumeg
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( Setting WAV file bit depth (WAV Bit Depth) )

You can set the bit depth of WAV files.

—
1. Press [vews]. 4. use @ to select the bit RIS

depth, and press @

—x
2. Use @ to select REC, MEN

FINDER

META DATA (for Next Take)
and press . W0y

MENU : Return

QUTPUT
o HINT

PLAY This can be set to 16-bit or 24-bit.

—x
3- Use @ to select WAV Bit

Rec to SD1 Tr1-8 ¢Poly>
Rec to SD2 Tr1-8 <Poly>
De p t h’ and press @ . Sample Rate 48kHz
WAV Bit Depth 24

MP3 Bit Rate 320kbps
Dual Channel Rec >

MENU : Return|




( Setting MP3 file bit rate (VIP3 Bit Rate)

You can set the bit rate of recorded MP3 files.

=
1 = Press . 4- Use @ to select the bit

rate, and press @

=
2. Use @ to select REC, MEN

FINDER

META DATA (for Next Take)
and press . D30

QUTPUT

MP3 Bit Rate

128kbps
192kbps

+ 320kbps

MENU : Return

REC HINT

PLAY

This can be set to 128 kbps, 192 kbps or 320 kbps.

—x
3- Use @ to select MMP3 Bit b

Rec to SD1 Tr1-8 cpoly>
Rec to SD2 Tr1-8 (Poly>
Ra t e, and press @ i Sample Rate 48kHz
WAV Bit Depth 24

MP3 Bit Rate 320kbps

Dual Channel Rec »

MENU : Return|

(818Y 11g £dIN) 81e4 11 81y £dIN Bumes
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[ Simultaneously recording tracks at different levels (Dual Channel Rec)

Along with regular recording, the F8 capture a second recording set to a different input level (dual channel recording).
For example, by using dual channel recording to record at an input level 12 dB below that of the regular recording, you have an
immediate replacement if the regular recording distorts because the track level is too high.

Dual channel recording can be used with tracks 1-4.

1 = Press . 4_
=N
2 = Use @ to select REC, MENU

FINDER

META DATA (for Next Take)
and press . W0y

OUTPUT
REC

PLAY 5
: [ ]

=
3- Use @ to select Dual
Rec to SD1 Tr1-8 ¢Poly>

Rec to SD2 Tr1-8 <Poly>
Channel Rec, and press . SangtelRefia ik

WAV Bit Depth 24

MP3 Bit Rate 320kbps
Dual Channel Rec >

MENU : Return|

3
Dual CF | Re (20|
Use @ to select the track, 1oL Shanne et

Input 1

Input 2
and press . Input 3
Input 4

Al

MENU : Return

Input 1

oC

)

Use to select On,
Off

and press @

When dual channel recording is
on, the name of the correspond-
ing second track (5-8) changes.

MENU : Return




6. Turn :? for the dual channel recording track to

adjust the input level.

For example, when track 1 is selected, adjust for track 5.

HINT
Dual channel recording increases the amount of space used on SD

cards.

e When using dual channel recording, the track that is numbered

4 higher than the original track is used for the second recording.
For example, track 5 is used for the dual channel recording of
track 1 and track 6 is used for track 2. Dual channel recording
tracks cannot be used independently.

e When dual channel recording is enabled, if stereo-linking is
enabled or disabled for tracks 1/2 or 3/4, the same setting will be
applied to tracks 5/6 or 7/8.

® The limiter, high pass filter and other functions can be set inde-
pendently for the regular and dual recording tracks.

e When a mic capsule is connected, its dual recording track input

level is fixed at —12 dB compared to the regular track.

(0o8Yy |auuey) |BNQ) S|8A8| JUBIBYIP 18 Syoel) Bulpi0oal Ajsnosuelnwig
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[ Capturing audio before recording starts (Pre Rec)

The input signal can be captured for up to 6 seconds before is pressed (pre-recording).

This is useful if, for example, is pressed too late.

1.

2.

Press .

3
Use @ to select REC, MENU

FINDER

META DATA (for Next Take)
and press . Wl
OUTPUT

REC

PLAY

=\
Use @ to select Pre Rec, =
Rec to SD2 Tr1-8 <Poly)
Sample Rate 48kHz
and press @ . WAV Bit Depth 24
MP3 Bit Rate 320kbps

Dual Channel Rec »
Pre Rec Off

MENU : Return

Use to select On, o
Off

and press .

)

MENU : Return

File format Sampling rate Maximum pre-recording time
44.1kHz 6 seconds
47.952kHz 6 seconds
47.952kHz(F) 6 seconds
48kHz 6 seconds

WAV 48.048kHz 6 seconds
48.048kHz(F) 6 seconds
88.2kHz 3 seconds
96kHz 3 seconds
192kHz 1 second

MP3 44.1kHz 6 seconds
48kHz 6 seconds




[ Maximum file size (File Max Size)

)

The maximum size of recording files can be set. If a recording file exceeds the maximum file size, recording will continue in a
new take with a number that is one higher. No gap will occur in the sound between the two takes when this happens.

1 = Press .

=\
Use @ to select REC,

and press @

)

Use @ to select File Max
Size, and press @

MENU L]

e

FINDER »
»
»
»

META DATA (for Next Take)

INPUT

QUTPUT

REC »
PLAY »

MENU : Return|

oc
Sample Rate 48kHz
WAV Bit Depth 24
MP3 Bit Rate 320kbps

Dual Channel Rec »
Pre Rec Off
File Max Size »

MENU : Return|

a

5.

File Max Size

e\
Use @ to select Size,

and press @

Size
Time Counter

File Max Size

SI2MB

=
Use @ to select the
640MB

maximum size of recording LG8

files, and press @

MENU : Return

HINT

Settin

backing up to CDs.

g the maximum size to 640MB or 512MB is convenient for

(9215 Xe B]14) 821S 8|1y WNWIXE
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[Showing total recording times for long recordings (Time Counter)

When recording for a long time, if the file size set with "File Max Size" is reached, recording will continue in a new take and
the recording time will reset. You can change this, however, so that it is not reset and the total recording time is shown.

1.

Press .

==
Use @ to select REC,

and press @

—x ’
Use @ to select File Max

Size, and press @

MENU "z

BC

FINDER 4
4
4
»

META DATA (for Next Take)

INPUT

QUTPUT

REC »
PLAY »

MENU : Return|

oC
Sample Rate 48kHz
WAV Bit Depth 24
MP3 Bit Rate 320kbps

Dual Channel Rec >
Pre Rec Off

File Max Size >

MENU : Return|

4. Use @

Counter, and press @

File Max Size L

to select Time ) -
Size 2GB

Time Counter Reset

N Time Counter
5- Use @ to select =

v Continuous

Reset
Continuous, and press @

Setting value

Explanation

When recording, even if the file size set with "Size" is

Continuous reached, the counter shown on the Home Screen will not
be reset.
When recording, if the file size set with "Size" is reached,
Reset the counter shown on the Home Screen will be reset to

000:00:00.




[ Folder and file structure

When recording with the I8 folders and files are created
on SD cards as shown below.
Folders and files are used to manage scenes and takes.

Folder and file structure

The folder and file structure differs according to the recording
file format. In addition, the names of folders and files depend
on how scenes are named.

ROIOI Order recorded —

HINT

e A "take" is a unit of data created for a single recording.
* A "Scene" is a unit containing multiple files and takes that com-
prise a single scene.

NOTE

e Enabling recording on SD cards and setting file formats (— P.24)

e Setting how scenes are named (mode) (= P42)

E First scene

E Next scene

User created
folder

150101 150102 Scene001
| I |
smmmmedenaaan <. P R T . . J L L e T T
H 1 N . H I - . :
. ' . ] ] ] ' ) ] . .
' P ' " ' . ] . : : : :
H H ! 150101-T003 WAV S H V1 Scene001-TO0T. WAV :
+ 150101-TO0T WA+ ' A vt 150102-T001. WAV v 150102-T002 WAV H N '
LS 4o [ m D ~ SO A :
1 . . ' 1] Ll
Scene 150101 Scene 150101 ' - 4 Scene 150102 ' '
' 150101-T003_TrL WAV~ % ! H ' Scene001-T001_TrIWAV
(1st take) (2nd take) : v 1501027001 Trl_2WAY ' (2nd take) H - H
WAV format MP3 format H | o o ' WAV format F ™ '
Poly file Stereo file : D . I : Poly file : D :
H P '
: 150101-T003 T2 WAV~ 1 % H : Scene0OTTO0T_T2WAY 1
H N Vo 150102-T001_Tr1_2_DWAV H H
1 . . ' 1] 5 .
o P : A :
' P '
: 1501011003 T3 WAV ¢ ! H H Scene001TOOT_TWAY  +
H o 160102-T001_TL RWAV & H H
H . DNl - H N H
' L P ' P P '
' H Scene 150102 ' '
H 150101-T003 T WAV 3 (1st take) ' Scene001-T001_Tra. WAV |
Cessecsscsssmssmsaman. 4 WAV format AR e L -
Scene 150101 Stereo file (track 1-2) Scene Scene001
(3rd take) Dual channel recording file (tracks 1-2) (1st take)
WAV format Stereo file (L/R tracks) WAV format

Mono files (tracks 1-4)

Mono files (tracks 1-4)

81N30N11S 8|1 pue 18p|04
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[ Folder and file structure (continued)

Take names

Structure

Explanation

Scene001-T0OO1

Take number
(001-999)
Scene number
(1-9999)
Scene name

Scene name: Select none, the folder
name, the date or a name input by
the user (— P42).

Take number: This number increases
by 1 for each recording made with
the same scene name and number.

Audio file names

File names are given by the -8 according to the file for-
mat—poly, mono or stereo.Track numbers and other data are
added to file names.

File names

File names are given according to the following formats.

Type Structure Explanation
This is a file created
Scene001-T001.wav by poly recording.
Poly file Audio for multiple
Take name tracks is recorded to
a single file.
Scene001-T001_Tr1.wav
Mono This is a file created
file Track number by mono recording.
Take name
Scene001-T001_Tr1_2.wav
Stereo |_ This is a file created
file Track number by stereo recording.
Take name
Dual Scene001-TO01_Tr1_D.wav o
channel Letter added to| This is a file created
record- dual channel | by dua_l channel
ing file Take name  Track number recording file | recording.
HINT
When recording with a Mono/Stereo setting, the audio files are
saved in the take folder that is created.




[ Moving the previously recorded take to the FALSE TAKE folder

If the just recorded take was a failure, you can use a shortcut to move the recording to the FALSE TAKE folder.

1 = Open the Home Screen.

Scene(01-T001
-6 -1z -5

-45 -20

2. Press and hold .

HINT
e Moving the take recorded most recently to the FALSETAKE folder

will reduce the number of the take recorded next by 1.
e Even during recording, you can move the previously recorded
take to the FALSE TAKE folder.

=)
3- Use @ to select Yes, st :
Move To FALSE TAKE Folder.

SD1:Scene001-TOOLWAV
and press i ol SD2:Scene001-TOOLWAV

Are you sure?

18p|04 IHVL IS TV 8y} 01 8xel papiodad Ajsnoiasid syl Buiro
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[ Changing the note for the next take recorded (Note)

You can input characters for a note to use as metadata in the file.

Editing notes

—=x
4. Use @ to select Edit,
N MENU
2 = Use @ to select META _— and press .

1 = Press .

Track Name >
Take Reset Mode Folder Change

MENU : Return|

O

3

a

2 DATA (for Next Take), IONU'j;TUT

5

@

3 and press @

@

S 5 = Edit the note.

=

it — See "Character input screen”
v] -
A 3- Use @ to select Note, META DATA (for Next Toke) R3S (= P13) for how to input
g characters.

> @ Scene Name Mode Date

3 and ress . User Scene Name >

8 p Scene Increment Mode Numeric

o

@

Q

z

S

e

Note =)

e

Edit No Slate

History >

Return

No Slate|

REW/FF:¢-/ > MENU : Cancel

| This note is written to the <NOTE> metadata. |

P Continue to one of the following procedures.

Editingnotes . ....... .. . P40
Selecting notes from the history list . ................ P41

40



Selecting notes from the history list

P ‘ -
4. use @ to select History, tote &

Edit No Slate

and press .

MENU : Return

2R Hist )|
5 = Use to select the item el =
+ No Slate |
Environmental Noise
to use, and press . tawe
<None>

<None>
<None>

MENU : Return

The history list will be erased if the Factory Reset function is used.
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[Setting how recorded scenes are named and numbered

You can set how scenes are named (name mode), the base scene name and how scene numbers advance.

1 = Press .

=)

Use @ to select META MEN

FINDER

META DATA (for Next Take) »

INPUT

DATA (for Next Take),

and press @

» Continue to one of the following procedures.

OUTPUT

Setting how scenes are named (mode)............... P42
Changing SCENE NAMES. « . v v vt i i i i ii e P43
Selecting a scene name from the history list ... ....... P44
Setting how scene numbers advance ................ P44

Setting how scenes are named (mode)

3.

3
Use @ to select Scene Name

Mode, and press @

Use

O

to select the mode,

and press @

META DATA (for Next Take) "EEE

Note »
Scene Name Mode Date
User Scene Name: 4
Scene Increment Mode Numeric
Track Name »
Take Reset Mode Folder Change

MENU : Return

Scene Name Mode L

None
Current Folder

User Name

MENU : Return



Setting value

Explanation

None

The scene name and number are not used.

When recording files are created, they are named only
with the take number, such as "T001", "T002", "T003" and
so on.

[=J+[>] cannot be used to advance the scene number
by 1.

Example: TO01.wav

Current Folder

The name of the currently selected folder is used as the
scene name.

[=]+[>] can be used to advance the scene number
by 1. After advancing the scene number by 1, the cor-
responding folder will be used as the recording des-
tination. If that folder does not already exist, it will be
created.

Example: FOLDER0O1-T001.wav

Date

The date is used as the scene name.

[=J+[>] cannot be used to advance the scene number
by 1.

If recording occurs after the date changes, a scene folder
with the date will be created.

Example: 20150101-T001.wav

User Name

A scene name input by the user is used.

[(=J+[>] can be used to advance the scene number
by 1.

No folder is created in this case.

Example: MYSCENEOO01-T001.wav

Changing scene names

If Scene Name Mode is set to User Name, set the scene name
used like this.

e\
3. Use @ to select User Scene

NOTE

Name, and press @

—x
Use @ to select Edit,

and press @

Edit the scene name.

See "Character input screen”
(= P13) for how to input
characters.

META DATA (for Next Take) {E28]

Note >
Scene Name Mode Date

User Scene Name >

Scene Increment Mode Numeric
Track Name >

Take Reset Mode Folder Change

MENU : Return|

User Scene Name )

bC
Scene001
4

Return

Scene001]

MENU : Cancel

The scene name is written to the <SCENE> metadata.

You cannot put a space or an @ mark at the beginning of the name.
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[ Setting how recorded scenes are named and numbered (continued)

Selecting a scene name from the history list

3.

e\
Use @ to select User Scene

Name, and press @

META DATA (for Next Take) (28]

Note >
Scene Name Mode Date

User Scene Name >
Scene Increment Mode Numeric
Track Name >
Take Reset Mode Folder Change

MENU : Return

Setting how scene numbers advance

=3
3. Use @ to select Scene

Increment Mode, and

press @

META DATA (for Next Take)

Note »
Scene Name Mode Date
User Scene Name

Nut

Take Reset Mode

Folder Change

MENU : Return

paJaquinu pue psweu 81e Saugds peplodal moy Buimes

7 User Scene N L A Scene Increment Mod
4. Use @ to select History, SSEEAE q. Use @ to select how e S
Scencl1

Character

scene numbers advance,

and press @

Setting value

and press @

MENU : Return

Explanation

5 = . e — . Press + on the Home Screen to increase the
[ ] Use to Select the item Numeric scene number by one.
Cenel
Scene002 | Example: Scene = Scenel — Scene2 — ... = Scene9999
to use, and press . <:"”E> Press (=] + [>] on the Home Screen to advance the
<None>
<None> capital letter at the end of the scene name by one.
<None> Character If the scene name does not have a capital letter at its end,

one will be added.
Example: Scene1 — Scene1A — ScenelB — ... =
Scene1Z — Scenel1AA — ScenelAB — ...

[ The history list will be erased if the Factory Reset function is used. |




F8 Muiti Track Field Recorder

)

HINT

On the Home Screen, (=] +

number by one.

can be used to advance the scene

e
[
Q
[©]
=
=
=]
«Q
—
)
=~
()
o
(0]
=3
=]
[(e]
(2]
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[Setting the take reset condition and numbering format

You can set the take number reset condition and take number format used when recording.

1.

2.

Press .

=)

Use @ to select META

DATA (for Next Take),

and press @

Setting the take number reset condition.............. P46
Setting the take name format....................... P47

MENU
FINDER

META DATA (for Next Take) »

INPUT

OUTPUT

» Continue to one of the following procedures.

Setting the take number reset condition

3.

—x
Use @ to select Take Reset

Mode, and press @

)

Use @ to select the reset

mode, and press @

META DATA (for Next Take) "EEE

Note 4
Scene Name Mode Date
User Scene Name: 4
Scene Increment Mode Numeric
Track Name »

Take Reset Mode Folder Change

MENU : Return

Take Reset Mode

Off
+ Folder Change

Setting value

Explanation

Off

The take number will not be reset.

However, if the folder is changed and that folder con-
tains a number higher than the current take number,
the take number will be set to one higher than the
highest existing take number.

Folder Change

in that folder.

If the destination folder is changed, the take number
will be set to one higher than the highest take number




Setting the take name format

3 META DAT Next Take)
ATA (for Next Take!
= Use to select A (fo =
Scene Name Mode Date
User Scene Name »
Ta ke N ame F ormat Scene Increment Mode Numeric
)

Track Name

Take t Mode Folde
and press i Take Name Format Scene

=\
4- Use @ to select the

"Scene™_***
format, and press .

MENU : Return

Setting value Explanation

"Scene"-T***
Take number
Scene name

"Scene"-T***

Example: Scene001-T001

"Scene"-***
_L Take number

"Scene"_***
Scene name

Example: Scene001_001
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[ Changing the track name of the next take recorded (Track Name)

The track name set with the following procedure will be given to the next recorded track.

—
1. press [oew]. 4. use @ to select the track, il

Track 1
@ Track 2 2
and ress . Track 3 Tr3
2 =) N P Track 4 Trd
= Use to select META Y Track § Ir5
FINDER Track 6 Tr6
T
DATA (for Next Take), il
OUTPUT
@ REC » Continue to one of the following procedures.
PLAY
and press ’ MENU : Return Editing thetrackname ............ ... ... .. ... ... P49
Selecting a track name from the History list. .......... P49
3 N META DATA (for Next Take)
= Use to select Track "
ote »
Scene Name Mode Date
Nam e n d r User Scene Name b
ra p ess . Scene Increment Mode Numneric

Track Name
Take Reset Mode Folder Cl

MENU : Return

HINT
On the Home Screen, + (2] can be used to open theTrack Name

screen.




Editing the track name

—x
5- Use @ to select Edit,

and press @

6. Edit the track name.

See "Character input screen"
(— P13) for how to input
characters.

Track 1

MENU : Return

REW/FFi¢/ =

MENU : Cancel

| The track name is written to the <TRACK> <NAME> metadata. |

Selecting a track name from the history list

3 -
5- Use @ to select History, Lt

and press @

MENU : Return

e
6. Use @ to select the item

Boom

Mic
to use, and press @ Lie
Wireless

Mix
Actor

MENU : Return

The history list will be erased if the Factory Reset function is used.
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[ Playing recordings

;

0000 000000 @ 000000

-
- @ - @ - @
o w4 (F s A

@ 000000
D
Cro s

b b
@ 00000 @nnn_qnn E]nnn_onn
° @ ° .' i o @

(A (G

100000
@

?@a@ @ g

HINT

1 = Press -

= Playback operations

Select take or jump to mark:

Search backward/forward:

Pause/resume playback:

Tracks that have no playback files
appear gray.

Press (=]

11

Press or
Press and hold [(=J/(=]

e The longer you press and hold [=]/[>], the faster the backward/
forward search speed.

e During playback, press track keys to switch between playing back
(lit green) and muted (unlit).

e An "Invalid Take!" message will appear if the selected take is not

valid.

A "NoTake!" message will appear if no take exists.

During playback, you can press to add a mark that can be

used for skipping. (= P. 152)

2 = Press to return to the Home Screen.




[ Mixing takes

You can change the volume and panning of each track during playback.

1 = Open the mixer on the Home

Screen. (- P11)

2 = Press to start

playback.

3 = Adjust the parameter settings.

= Editing operations

e

)
Move cursor or change value: Turn @

Select parameter to change:

Press @

Parameter | Setting range Explanation

Fader Mute, -48.0 - +12.0 dB | Adjusts the level of the signal.

Adjusts the left-right stereo position

Panni L100 - Center - R100
anning enter of the sound.

HINT

e You can turn @ to move the cursor, and also adjust the settings
of the MAIN OUT 1/2 and SUB OUT 1/2 tracks (— P.102).

e When a fader or pan knob is selected, press and hold @ to
reset it to its default value. If already set to its default value,

selecting a fader mutes the track.

NOTE

e Settings are saved separately for each take and are used during

playback.

e Mix settings are not saved with the take when the format is MP3.

saye1 Buixip
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[ Monitoring the playback signals of specific tracks during playback ]

You can monitor the playback signals of specific tracks using SOLO mode.

1.

2.

Open the Home Screen.

Press to start

playback.

Press on the tracks that

you want to monitor.

The background colors for the
selected tracks will become
green, and their track indicators
will light orange.

: WAy 48.000
SD2 : MP2 320kbes

Scene001-T001
-6 -1z -

-5 =20

BB : way 48.000  (DZFE

Scene001-T001

-45 -20  -16 -1z

EBE: WAV 48.000 (DI2)3)E)

SOLO mode can only be used with tracks that can be played back

(indicators lit green).

4. Press of a track being monitored to stop

monitoring it.



[Changing the playback mode (Play Mode)

You can change the playback mode.

Setting value Explanation
Play One
1 Press.. Only the selected take will be played.
- (single playback) nly the selected take will be playe
Play All Takes will be played back continuously from
= (all playback) the selected one until the last take.
MENU
2 Repeat O
= Use @ to select PLAY, FINDER (.apea ne The selected take will be played repeatedly.
(single repeat playback)
META DATA (for Next Toke> Repeat All All takes in the selected folder will be played
and press . INPUT P play
OUTPUT (all repeat playback) repeatedly.

=)
3- Use @ to select Play Mode, iy
and press @

MENU : Return

=\
Play Mod
4. Use @ to select the play oy Moce
Play One
+ Play all
mode, and press . Repezing
Repeat Al

MENU : Return

(epo|A Aeld) epow xoeqgAe|d ayy Buibuey)
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( Take and folder operations (FINDER)

The FINDER allows you to select and view the contents of SD cards, takes and folders, and to create project/scene folders. It also

allows you to, for example, set and delete recording/playback folders and view their information.

= SD card selected

1 = Press . . FINDER

. SD1 Free:
Size:
50 5D2: F8_SD2 Remain
—x
MENU
2. Use () toselect FINDER,
META DATA (for Next Take)
and press . IRl ENC (hold) : Option
QUTPUT

REC
PLAY
= Folder selected

D1: F8_SDI 20

W o
FALSE TAKE »

K Scene001-T001

& Scenel01-T002

& New Folder

ENC (hold) - Option

)

3. Turn @ to select the SD FINDER

4 SD1 : F8_SD1

= SD2 : F8_SD2 Remain: 003450

card, folder or take that you

want to use.
[ENC (hold) : Option

= Take selected

= Editing operations 56 SD1 : F8_SD1
= 1T TRASH
Move cursor: Turn @ BEFAL SE TAKE

B 170101
Move down a level: Press @ Ei Scene001-T001

&2 Scene001-T002

Bk New Folder »
ENC (hold) - Option

Move up a level: Press

Free space
Size
Recordable time

Date
Time

Timecode

Frame rate
Length

Recording format
Date created
Time created
Size

MS Side mic level



Creating folders

* When the cursor is on a take, you can press to play the Folders can be created inside the currently selected SD
selected take.You can also use [=], and [(=]. card/folder.
e A check mark appears on the playback take and recording/play- P S
back folder. 4- Use @ to select New ﬁTRASH -
BE FALSE TAKE
| 170101
Folder, and press @ B Scene0ul_T001
» Continue to one of the following procedures.
Creating folders ...P55
Selecting the take recording/playback folder.................. P56
Checking take marks and using them for playback........ P56
Changing folder and take names...........ccceceeciiiiiiiiienns P57 5 = Edit the folder name.
Copying takes to other cards and folders .........ccccceeueenne P57 .
. See "Character input screen"
Deleting folders and takes........c..ccceeunee ...P58 (~ P13) for how to input
Emptying the TRASH/FALSE TAKE folder........ccccvevriunen. P59 char;alcters.

MENU : Cancel

e The folder created will be set as the recording folder.

e The name of the folder created is written to the <PROJECT> or
<SCENE> metadata.
* You cannot put a space or an @ mark at the beginning of the

name.
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[ Take and folder operations (FINDER) (continued)

Selecting the take recording/playback folder

Use this procedure to select the folder that contains the take
to be played or the folder to use for recording takes.

4. Press and hold @

e\
use @ to select Select,

and press @

Option

Select

Mark List

Rename Scene001-T001
Meta Data Edit

Copy

Delete

e The first take inside the selected SD card or folder will be set as

the playback take.

e After selecting the take recording/playback folder, the Home

Screen will reopen.

Checking take marks and using them for playback

You can view a list of the marks in a recorded take.

4- Press and hold @ Option

Select

N Mark List
use @ to select Mark |_-| st Rename Scene001-T00L

Meta Data Edit

Copy
and press . Delete
o)
5- Use @ to select a mark, and press @

The Home Screen will reopen, and playback will start from
the mark.

Mark List
Added Mark

Indicates that a mark
was added during a
recording error.

MENU : Return



Changing folder and take names

4.

Press and hold @

e
use @ to select Rename,

and press @

Edit the folder/take name.

See "Character input screen"
(— P13) for how to input
characters.

e The edited name of the folder/take is written to the
<PROJECT> or <SCENE> metadata.

* You cannot put a space or an @ mark at the beginning of

the name.

Option

Select

Mark List

Rename Scene001-T001
Meta Data Edit

Copy

Delete

Rename

Scene002-1001

MENU : Cancel

Copying takes to other cards and folders

4.

Press and hold @

e
use @ to select Copy,

and press @

=\
Use @ to select the take to

copy, and press @

Press and hold @

Option
Select
Mark List
Rename Scene001-T001
Meta Data Edit »

Delete »
MENU : Return|

Copy

b
O K Scene001-T002
O K Scene002-T001
O B Scene002-T002
O B Scene003-T001
0O B Scene003-T002

PLAY : Al ENC (hold) : Copy to

(43aNI14d) suonmado 18p|o} pue axe|
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[ Take and folder operations (FINDER) (continued)

Deleting folders and takes

e
7. Use @ to select the Copy to o)

b A _
==l 4. Pressandhold (), N
copy destination, and B Scene003 » dlect
py I Scene(04 » AN Mark List
use to select Delete Rename Scene001-T001
press and hold @ ! Meta Data Edit 3
ENC (hold) : Execute MENU : Return golpi :
and press . Delete ]

NOTE

| See "Take and folder operations" for how to select a folder. (— P54) |

e\
5- Use @ to select the Delete

] m170101
O K Scene001-T0O01
8 Cony — folder/take to delete, and
= Use to select Yes,
Are you sure? press @ .
and press . PLAY : Al ENC (hold) : Execute

No Press to cancel deletion.

\ES

MENU : Return

You can press to select/deselect all the folders and takes that

are currently shown.

6- Press and hold @



e\
7. Use @ to select Yes, Delete

Are you sure?
and press .

No

MENU : Return

® Deleted folders and takes are not immediately erased from the
SD card.They are moved to the TRASH folder.
e Deleting the folders and takes in the TRASH folder will com-

pletely erase their data.

Emptying the TRASH/FALSE TAKE folder

—x
4. Use @ to select TRASH

or FALSE TAKE.

5- Press and hold @

so SD1 : F8_SD1 =)

bC
Date: 17/01/01]
Time:  11:44:55]

so SD1 : F8_SD1
1l TRASH » |Date: 17/01/01)

Time:  11:44:55)
ALSE TAKE 4

B New Folder

[ENC (hold) : Option

FALSE TAKE folder

(43aNI14d) suonmado 18p|o} pue axe|
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( Take and folder operations (FINDER) continued)

=X
6. Use @ to select Empty,

and press @

MENU : Return

P}

7. Use @ to select Yes, By

Are you sure?
and press .

No

MENU : Return

e Emptying the TRASH folder will completely erase the data in it.

e Emptying the FALSE TAKE folder will not immediately erase the
data in it from the SD card. Instead, this data will be moved to
the TRASH folder.




[ Information (metadata) stored in files

The IF BB writes a variety of information (metadata) to files
during recording.

When these files are read by an application that supports
metadata, you will be able to check and use the saved
information.

HINT

e Metadata is data that contains information related to other data.
The IF B saves scene names and take numbers, for example,
as metadata in audio files.

e A chunk is a unit that contains multiple data in a single block.

e To use BEXT and iXML chunk metadata, an application that sup-

ports both data formats is necessary.

WAV file metadata

The metadata saved in files recorded by the =8 inhwav
format is collected in BEXT (Broadcast Audio Extension) and
iXML chunks.

For information about the metadata saved in these chunks,
see the “Metadata contained in BEXT chunks in WAV files”
(= P169) and “Metadata contained in iXML chunks in WAV
files” (= P170).

MP3 file metadata

The metadata saved in files recorded by the 8 in vr3
format is written as ID3v1 tags.

For information about the ID3 fields and formats for saving
metadata, see the "Metadata and ID3 fields contained in MP3
files" (— P172).

HINT

« F 88 \viP3 files conform to the MPEG-1 Layer Ill standard.
e MP3 metadata cannot be edited.

61
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[ Checking and editing take metadata

1.

2.

Press .

—x
Use @ to select FINDER,

and press @

=)

Use @ to select the take,

and press .

This opens the Option Screen.
See “Take and folder operations”
for how to use the Finder. (— P54)

—x
Use @ to select Meta Data

Edit, and press @

MENU

FINDER

META DATA (for Next Take)
INPUT
OUTPUT

so SD1 : F8_SD1

1 TRASH
A FALSE TAKE Len:
170101 »

Bl Scene001-T001 Date: 17
Xt

& Scene001-T002 :

Bk New Folder »
[ENC (hold) : Option

Option

Select
Mark List

Rename Scene001-T001

Meta Data Edit »
Copy
Delete

MENU : Return|

» Continue to one of the following procedures.

Checking and editingnotes ............... ... ... P63
Selecting notes from the history list . ................ P63
Checking and editing scenenames.................. P64
Selecting a scene name from the history list .. ........ P64
Checking and editing takenames ................... P65
Circlingtakes..........ciiiiiii i P66
Editing folder (tape) names . ............ ..., P.66
Editing projectnames. . .......... . . i P67
Checking and editing track names................... P67
Selecting a track name from the History list. .......... P68



Checking and editing notes Selecting notes from the history list
=) —
B. use @ to select Note, - Meta Data "E 5. use @ to select Note, - MetaDatafat %%

Scene » Scene »
and press . S g and press . S g
Circle Not Circled Circle Not Circled
Folder(Tape) Name 170101 Folder(Tape) Name 170101

Pro ject Name 170101 Pro ject Name 170101
MENU : Return|

MENU : Return|

=) =)
6- Use @ to select Edit, _ a 6- Use @ to select History, -
No Siatte
History ’
and press @ and press @

Return MENU : Return

P\
7. Edit the note. 7. Use @ to select the item _— Fistory
+ No Slate
See "Character input screen" Environmental Noise
(— P13) for how to input to use, and press . z:z::i
characters. —

<None>
MENU : Return

MENU : Cancel

ez

| The content of this note is written to the <NOTE> metadata. | | The history list will be erased if the Factory Reset function is used. |
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[ Checking and editing take metadata (continued)

Checking and editing scene names

Meta Data Edit =m)
5. Use @ to select Scene, era tata oo

Note »

Scene »
and press . HS I
Circle Not Circled

Folder(Tape) Name
Pro ject Name

= . .
6- Use @ to select Edit, _ cene
Edit Scene001

History »
and press .

7. Edit the scene name.

Scene001]

See "Character input screen"
(— P13) for how to input
characters.

NOTE

| The scene name is written to the <SCENE> metadata. |

Selecting a scene name from the history list

=3
5. Use @ to select Scene,

and press @

=
6- Use @ to select History,

and press @

=)
7. Use @ to select the item

to use, and press @

NOTE

Meta Data Edit -

oG
Note >
Scene >
Take 1
Circle Not Circled
Folder(Tape) Name

Pro ject Name

Scene

Edit Scene001

History »

History —

Scene001 |

Scene002
<None>
<None>
<None>
<None>

[ The history list will be erased if the Factory Reset function is used. |




Checking and editing take names

=\
5- Use @ to select Take,

and press @

6- Change the take number.

= Editing operations

Meta Data Edit =

Note

Scene

Take

Circle
Folder(Tape) Name
Pro ject Name

=)
Move cursor or change value: Turn @

Select parameter to change: Press @

e

»
»

1
Not Circled

HINT

This can be set from 1 to 999.

NOTE

| The take number is written to the <TAKE> metadata.

When done changing,

e\
use @ to select Enter,

and press @

| Enter

MENU : Cancell

elepelsw ayel bunipe pue Buppay)
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[ Checking and editing take metadata (continued)

Circling takes

Use this function to add an @ mark to the beginning of the
name of the best take to make it stand out. This is called a
"circled take".

5.

3
Use @ to select Circle,

and press @

)

Use to select Circled,

and press @

Meta Data Edit =

bC
Note >
Scene >
Take 3
Circle Not Circled
Folder(Tape) Name 170101
Pro ject Name 170101

MENU : Return|

Circle —

Not Circled

+ Circled

MENU : Return

e To clear a circle, select Not Circled and press @

e This circled status is written to the <CIRCLE> metadata.

Editing folder (tape) names

5.

=)
Use @ to select Folder

(Tape) Name, and press @

Edit the folder (tape) name.

See "Character input screen"
(— P13) for how to input
characters.

Meta Data Edit =)

oC
Note

Scene
Take 3
Circle Not Circled
Folder(Tape) Name 170101
Pro ject Name 170101

MENU : Return

4
4

Folder(Tape) Name
170101

e The folder (tape) name is written to the <TAPE> metadata.

e The folder (tape) name used immediately after recording is the

name of the folder in which the take was recorded.

e You cannot put a space or an @ mark at the beginning of the

name.




Editing project names

e
5. Use @ to select Project

Name, and press @

6- Edit the project name.

See "Character input screen"
(— P13) for how to input
characters.

Meta Data Edit L]

e
Note

Scene
Take 3
Circle Not Circled
Folder(Tape) Name 170101
Pro ject Name 170101

»
»

Pro ject Name

170101

The project name is written to the <PROJECT> metadata.

The project name used immediately after recording includes the

name of the highest level folder (inside the SD card root direc-

tory) that contains the folder in which the take was recorded.

You cannot put a space or an @ mark at the beginning of the

name.

Checking and editing track names

5.

Z—\
Use @ to select Track

Name, and press @

=
Use @ to select the track,

and press @

—x
Use @ to select Edit,

and press @

Scene

Take

Circle
Folder(Tape) Name
Pro ject Name

Track Name

Track 2
Track 3
Track 4
Track
Track 6

Not Circled
Pro ject001
Pro ject001

»
MENU : Return

MENU : Return
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[ Checking and editing take metadata (continued)

8. Edit the track name.

See "Character input screen"
(— P13) for how to input
characters.

REW/FF:</ > MENU : Cancel

The track name is written to the <TRACK> <NAME> metadata.

Selecting a track name from the history list

=)
5- Use @ to select Track

Name, and press @

=)
6- Use @ to select the track,

and press @

=x
7. Use @ to select History,

and press @

Circle
Folder(Tape) Name

Pro ject Name

Track Name

Track Name
Track 1
Track 2
Track 3
Track 4
Track ©
Track 6

Track 1

Edit
History

Not Circled
Pro ject001
Pro ject001

»

MENU : Return

MENU : Return




=\
8. Use @ to select the item

to use, and press @

The history list will be erased if the Factory Reset function is used.

Mic

Line
Wireless
Mix
Actor

MENU : Return
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(Writing sound reports (Create Sound Report)

A sound report includes information about recording times and takes.

Reports can be written as CSV format files (F8_[folder name].CSV).You can edit the comments written in sound reports.

1 = Press .
=
2 = Use @ to select FINDER, £

META DATA (for Next Take)
and press . Ml
OUTPUT

REC
PLAY

=
FINDER i)
3- Use @ to select the folder _ PN
= e

so SD2 : F8_SD2 Remain: 00350
or SD card for which you

want to create a sound

ENC (hold) : Option

report, and press and

hold @

3
Optiof
4. Use @ to select phm C

Select

Create Sound Report »

Create Sound Report,

and press @
MENU : Return

» Continue to one of the following procedures.

Writingasoundreport .......... ... i P.71
Editingcomments. ........ ... i e P.71
Selecting comments from the history list............ P. 72



Writing a sound report

5.

A
Use @ to select Create,

and press @

e\
Use @ to select Yes,

and press @

This writes the sound report
inside the selected SD card or
folder.

Info Edit

MENU : Return

Are you sure?

No

MENU : Return

e Only information about takes in the folder or SD card is written

in the sound report.

e |If a sound report file with the same name already exists, it will be

overwritten. Please use caution.

Editing comments

5.

—x
Use @ to select Info Edit,

and press @

Use to select Comments,

and press @

—x
Use @ to select Edit,

and press @

)

Edit the comment.

See "Character input screen”
(= P13) for how to input
characters.

Create Sound Report

Create

MENU : Return

MENU : Return

REW/FF:</

MENU : Cancel
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[Writing sound reports (Create Sound Report) (continued) ]

Selecting comments from the history list

= =)
. Create

5- Use @ to select Info Edit, B i 8- Use @ to select the item
Create »

<None>

and press . to use, and press @ <:°"E"

<None>

<None>

<None>
MENU : Return MENU : Return

6 Info Edit HINT
= Use to select Comments, ( The history list will be erased if the Factory Reset function is used.

and press @

=
7. Use @ to select History,

and press @

MENU : Return



Input and output signal flow
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_ Fader _
| |
_ Routing _
o] 5
° el
©
| I
o a

Input Delay

MS Stereo

Phase Invert

Input Limiter

HPF

Trim

Dual Channel Rec
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[Adiusting the input signal monitoring balance ]

You can adjust the volume and panning of each input signal when monitoring during recording.

1.

Open the mixer on the Home

Screen. (— P11)

Adjust the parameter settings.

= Editing operations

=)
Move cursor or change value: Turn @

Select parameter to change:

Press @

HINT

Parameter Setting range

Explanation

Fader Mute, -48.0 - +12.0 dB

Adjusts the level of the input
signal.

® You canturn @ to move the cursor, and also adjust the settings
of the MAIN OUT 1/2 and SUB OUT 1/2 signals. (= P.102)

e When a fader or pan knob is selected, press and hold @ to
reset it to its default value. If already set to its default value,

selecting a fader mutes the track.

NOTE

e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

e These volume and pan settings only affect the monitoring signals

and the data being recorded on the L/R track.

Settings are saved separately for each take that is already
recorded and can be changed during playback. (— P51)

* Mix settings are not saved with the take when the recorded file
format is MP3.

Panning L100 - Center - R100

Adjusts the left-right stereo

position of the sound.




[Quickly setting fader/pan with input trim knobs (Trim Knob Option)

The input trim knobs can be used to quickly adjust the fader and pan settings of each track.

Setting the input trim knob function

1 = Press .

)

2 = Use @ to select SYSTEM, MENU

OUTPUT

REC
and press . Ay
TIMECODE

SLATE

SYSTEM

)
3. Use @ to select Trim Knob ,
Home Timecode

Level Meter
0pt]0n, and press @ LED Brightness
LCD
PLAY Key Option
Trim Knob Option Trim

MENU : Return

)
4 - Use @ to Select M.l xe r' Trim Knob Option

Trim

and press

MENU : Return
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[Quickly setting fader/pan with input trim knobs (Trim Knob Option) (continued) ]

Adjusting fader and pan settings with input trim
knobs

1 = Open the mixer on the Home

Screen.

IS0 : wAv 48.000
SDZ : MP3 320kbps.

=\
2 = Use @ to select the

parameter you want to

adjust, and press @

000
SD2 : MP2 320kbes

'; of the track you want to adjust to change

its setting value.

HINT
The position of the knob on the display always shows the current

setting.

For example, after changing the parameter to be adjusted, if the

positions of

10

and the knob on the display are different, the

knob on the display will appear gray, and movivr_lvg F will not

affect that setting. In this case, if you adjust to match the

position of the knob on the display, the display knob and

be relinked, and you will be able to use

value again.

Parameter with different

k position
%5

0
and setting value

S : WAy 48.000
SD2 : MP3 320kbrs




[ Adjusting the L/R track volume

1 = Open the Home Screen.

Scene(01-T001
-6 -1z -5

-45 -20

2. Press + .

| Shortcuts are disabled during playback. |

3. Use @ to adjust the .L,RUOO'OO'OO 061581 %

volume.
Scene001-T001

45 -z0  -16 -1z
L

* WAV 48.000
SD2 : MP3 320kbes

¢ Volume settings affect the results of recording.
e If only the L/R track is recorded, the L/R track fader setting for the
take will be saved as 0dB.

4. When finished adjusting, press or + .
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[ Monitoring the input signals of specific tracks (PFL/SOLO) ]

You can monitor the input signals of specified tracks. Even tracks that have not been set to record can be input to the PFL screen
and their input sounds monitored. This is convenient when using tracks as return inputs. You can also make various settings for
these tracks.
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Parameter Explanation
. Side Mic Level This sets the side mic level of id-side mi le.
1 = Press on the tracks that you want to monitor. 1de VIic ~eve 1S Sets the side mic eve’ 4 mic-sice mic capsue
Input Delay This sets the input delay.

The selected track keys will light orange, and the PFL screen

will open.

Plugin Power

This sets the plugin power.

. Stereo Link This sets the stereo link.
"PFL" or "SOLO" appears at the top of the display, and you Stereo Link Mode | This sets the stereo link mode.
will be able to monitor the input signal with headphones. PFL Mode This sets the monitoring volume on the PFL screen.
PFL mode
NOTE
Track 1 : PFL @ This does not change the signals output from MAIN OUT and SUB
Trim  Mic+40dB  Line:+20dB OUT.
Phantom Off
HPF Off Parameter names
Input Limiter: Off HINT
Fader +0.0dB e Use @ to select parameters and change setting values.
Pan Center
T Level meter
-45 =20  -16  -12 (prefader input
signal level)

2 = Press or for the monitored tracks.

Parameter Explanation This closes the PFL screen and restores the original head-
Phantom This sets phantom power. phone monitoring signal.
HPF This sets the high pass filter.
Input Limiter This sets the limiter.
Fader This sets the fader level.
Pan This sets the panning.
Phase Invert This sets the phase.




[Setting the monitoring volume on the PFL screen (PFL Mode)

On the PFL screen, you can set the monitored sound to be either prefader listening (PFL) or postfader solo (SOLO).

1 = Press .

—x
2. Use @ to select INPUT, M G

FINDER

META DATA (for Next Take)
and press .

—x
3- Use @ to select PFL Mode,

Phantom

Plugin Power
and press . Input Delay
Stereo Link Mode

Trim Link

PFL Mode »
MENU : Return

Input 2
and press . Input 3
Input 4

=
4- Use @ to select the track, P Mode

Input 1

Input 5
Input 6

MENU : Return

HINT

Select ALL to set all the tracks at the same time.

)
5- Use @ to select the mode, it 1 =

SOLO
and press .

MENU : Return

Setting value

Explanation

PFL

Monitor the prefader sound.

SOLO

Monitor the postfader sound.
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[ Cutting low-frequency noise (HPF) ]

The high pass filter can cut low frequencies to reduce the sound of wind, vocal pops and other noise.

=
1 = Press . 4. Use @ to select the input, =

Input 1 Off

Input 2 Off
and press Input 3 Off
Input 4 Off

Input b Off
Input 6 Off

MENU : Return

FINDER

META DATA (for Next Take)
and press . N

QUTPUT

REC HINT

PLAY - -
Select ALL to set all inputs at the same time.

—x
2. Use @ to select INPUT, M

3 —
(]| k N
= Use @ to select PF, HPE > 5 = Use @ to set the cutoff R

Input Limiter >

and press @ . Phase Invert »
Phantom 3 frequency, and press .
Plugin Power Off
Input Delay 3

MENU : Return

MENU : Return

NOTE

| The HPF also affects dual channel recording data. |

HINT
This can be set to Off or between 10 and 240 Hz.




[ Input limiter

The limiter can prevent distortion by controlling input signals
that have excessively high levels.

Original helease

. time
signal

Limited
signal \

Attack
time
Level

Threshold

Time

When the limiter is ON, if the input signal level exceeds the
set threshold value, the signal level will be suppressed to pre-
vent the sound from distorting.

The attack time is how long after the signal exceeds the
threshold before the limiter starts operating.The release time
is how long after the signal goes below the threshold before
the limiter stops operating.You can change these two param-
eters to adjust the sound quality.

HINT
e The F 8 has a newly designed limiter that provides 10 dB

of headroom, allowing signals to be kept well below the set

threshold, therefore more effectively preventing distortion.

o The IF B limiter uses a ratio of 20:1.

1 = Press .

—x
2- Use @ to select INPUT,
FINDER

META DATA (for Next Take)
and press . AL
OUTPUT

REC
PLAY

=)
3. Use @ to select Input et =

HPF >
Limiter, and press @

Input Limiter »

Phase Invert >
Phantom >
Plugin Power Off
Input Delay »

MENU : Return

Input Limiter )

bC

=)
4- Use @ to select the input,
Input 1 »

Input 2 >
and press . Input 3 >
Input 4 »
Input 5 »

Input 6 »
MENU : Return

HINT

Select ALL to set all the inputs at the same time.

Japwi| ndu|
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[ Input limiter (continued)

» Continue to one of the following procedures.

Using the lImiter.....cceiiiiiiiiei e P82
Setting the type ..oveviecc e P83
Setting the threshold

Setting the attack tiMe........coocerieeniiieiee e P84

Setting the release time ......cccccee e P84

Using the limiter
—x
5. Use @ to select On/0ff,

and press @

=
6- Use @ to select On, and

press @

Input 1 ]

e

On/Off off
Type Hard Knee
Threshold - 2dBFS

Attack Time 1ms
Release Time 200ms

MENU : Return

On/Off

bC

Off

v 0On

MENU : Return



Setting the type
=)
Input 1 -
5- Use @ to select Type, e o
On/Off Off
and preSS . Threshold - 2dBFS
Attack Time 1ms
Release Time 200ms:
MENU : Return
N
T )
6- Use @ to select the type, e =

Soft Knee
and press .

MENU : Return

Setting value

Explanation

Hard Knee

Only peaks that exceed the threshold are attenuated. There
is no effect below the threshold.

Soft Knee

The limiter gradually affects the signal about 6 dB below
the threshold for a gentler effect.

Setting the threshold

This sets the level at which the limiter begins operating.

ey
B. use @ to select Threshold,

and press @

=\
6- Use @ to adjust the
setting, and press .

On/Qff

Type
Threshold
Attack Time
Release Time

Input 1

Threshold

oG
off
Hard Knee
- 2dBFS
1ms
200ms

MENU : Return

MENU : Return

HINT

This can be set from -16 to -2 dBFS.
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[ Input limiter (continued)

Setting the attack time

input signal exceeds the threshold.

e
5- Use @ to select Attack

Time, and press @

Jaywi| indu|

=\
6- Use @ to adjust the time,
and press .

This sets the amount of time until limiting starts after the

Input 1

oC
On/Off

Type Hard Knee
Threshold - 2dBFS
Attack Time 1ms
Release Time 200ms

MENU : Return

Attack Time

MENU : Return

Setting the release time

This sets the amount of time until limiting stops after the

input signal goes below the threshold.

e\
5. Use @ to select Release

Time, and press @

=N
6- Use @ to adjust the time,
and press .

Input 1 )|

oc
On/Off Off
Type Hard Knee
Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms

MENU : Return

Release Time

MENU : Return

HINT

HINT

This can be set from 1 to 4 ms.

This can be set from 1 to 500 ms.

84




F8 Multi Track Field Recorder

)

e Limiter operation is linked for tracks that have stereo link or MS

stereo link enabled. If the signal for either linked channel reaches
the threshold, the limiter will operate on both tracks.
e When the limiter is operating, the right-most segment of the level

meter and the mixer limiter indicator on the display light yellow.
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[ Inverting the input phase (Phase Invert) ]

The phase of the input signal can be inverted.
This is useful when sounds cancel each other out due to mic positioning.

=
1. Press - 4. use @ to select the input, Phaselwert 8

Input 1 Off

Input 2 Off
and press Input 3 Off
Input 4 Off

Input 5 Off
Input 6 Off

MENU : Return

ey
2. Use @ to select INPUT, e

FINDER

META DATA (for Next Take)
and press . N
OUTPUT

REC
PLAY HINT

Select ALL to set all inputs at the same time.

B3
[
3. Use @ to select Phase - N a2 _—
npu

L 5. Use to select On, : =
nput Limiter > off

Invert, and press @ GLE <
Phantom > an d ess
Plugin Power Off pr "

Input Delay >
MENU : Return

MENU : Return




[Changing the phantom power settings (Phantom)

)

The F 83 can provide phantom power. The voltage can be set to +24V or +48V and it can be turned on/off for each input

separately.

HINT
Phantom power is a function that supplies power to devices that

require an external power supply, including some condenser mics.
The standard power is +48V, but some devices can operate with

lower voltages.

Do not use this function with a device that is not compatible with

phantom power. Doing so could damage the device.

1.

2.

Press .

=
Use @ to select INPUT,

and press @

)
Use @ to select Phantom,

and press @

MENU

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

INPUT

HPF

Input Limiter
Phase Invert
Phantom
Plugin Power
Input Delay

bC

4
>

BC

>
>
»

>
Off
>

MENU : Return

P Continue to one of the following procedures.

Using phantompower ........ ... ... .. ... P88
Settingthevoltage ......... ... ... . .. L, P88
Disabling phantom power during playback ........... P89
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[ Changing the phantom power settings (Phantom) (continued)

Using phantom power
=)
4. use( ) toselect 0n/0ft,

and press @

Phantom

On/Off >

Voltage (For All Inputs)
Power Saving (For All Inputs) ~ Off

On/Off

=
5- Use @ to select the input,

and press @

Input 1
Input 2
Input 3
Input 4
Input 5
Input 6

MENU : Return

HINT
Select ALL to set all inputs at the same time.

Input 1

= 21
6- Use @ to select On, Off

and press @

When a mic capsule is connected, phantom power is set to Off for

MENU : Return

inputs 1/2.

Setting the voltage

)
4- Use @ to select Voltage e =

On/Off 4

Voltage (For All Inputs) +48V

Power Saving (For All Inputs) ~ Off

(For A1l Inputs), and

press @

=)
5- Use @ to select the

voltage, and press @

Voltage (For All Inputs) ~ 1E=m]

bC

+24V

MENU : Return

HINT
When using mics and other equipment that can operate with volt-

ages less than +48V, selecting +24V can reduce power consumption

by the I B3.




Disabling phantom power during playback

=)
4. Use @ to select Power Phantom

On/Off

Voltage (For All Inputs)

Savi ng ( For A1l I npu ts ) , Power Saving (For All Inputs)  Off
and press @ .
5 e
Power Saving (For All Inputs) @
= Use @ to select On, e

+ On (Phantom of ng play back)
and press .

Setting value Explanation
Off Phantom power is supplied even during playback.
On (Phantom off Phantom power is not supplied during playback.
during play back) This can reduce the I &3 power consumption.

This setting affects all inputs.

HINT
If mics do not need phantom power during playback, disabling it

can reduce = B8 power consumption.
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[Changing the plugin power setting (Plugin Power)

Make this setting when a mic that is compatible with plug-in power is connected to the mic capsule’s MIC/LINE input jack.

1.

2.

Press .

—x
Use @ to select INPUT, M

FINDER

META DATA (for Next Take)
and press .

=
Use @ to select Plugin e

HPF

Input Limiter
Power, and press . Phase Invert

Phantom

Plugin Power
Input Delay

4
»

|
4
4
4
»

Off
>

MENU : Return

)
Use @ to select On,
and press @

MENU : Return



[ Delaying input signals (Input Delay)

If there are differences in the timing of input signals, use this function to correct them when recording.

1.

2.

Press .

—x
Use @ to select INPUT,

and press @

=\
Use @ to select Input

Delay, and press @

=
4- Use @ to select the input, Input Delay

Input 1

Input 2
and press . Input 3
Input 4

Input 5
Input 6

MENU 2w

FINDER
META DATA (for Next Take)

MENU :

BC

0.0ms
0.0ms
00ms
00ms
00ms
00ms

Return

HINT
Select ALL to set all inputs at the same time.
N
. Input 1
5- Use @ to adjust the delay i
HPF »
Tnput Limiter » time, and press .
Phase Invert »
Phantom »
Plugin Power Of f
Input Delay MENU : Return
MENU : Return
HINT

This can be set from 0 to 30.0 ms.

|When Sample Rate is set to 192kHz, Input Delay is disabled.
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[ Converting mid-side input to ordinary stereo (Stereo Link Mode)

Signals from a mid-side stereo mic input connected to stereo-linked inputs can be converted to an ordinary stereo signal.
See "Linking inputs as a stereo pair" (= P.26) for how to use stereo linking.

Mid-side stereo format overview 1 " Press .

This technique creates a stereo Mid mic

recording from signals input by a —

dlrectlo.nal mid mic that captu.re.s 2_ Use @ to select INPUT, MENU ]
sound in the center and a bidi- FINDER »
rectional side mic that captures and press @ ;’LEPTUATDATA(furNextTake) :
sounds from the left and right. pe— OUTPUT ’
Mid-side recording allows you to Efiv :
change the stereo width by the MENU - Return
adjusting the level of the side

mic. M | S+ | S- [Master

Since this technique can capture e | P | e =\

a wide stereo image, it is ideal Qn Q Q - 3- Use @ to select Stereo v "E
for recording open spaces with % % % %% Phase Invert >
numerous sound sources, such Link Mode, and press @ E::f’g';f‘;’:wer orr
as orchestras, live concerts and Tnput Delay »

soundscapes. ereo Link Mode

MENU : Return

Mid-side recording is also extremely effective when you want
to be able to control the amount of room ambience in a sig-
nal. For this reason, it is often used for live as well as studio
recording. In addition, the stereo signal created by this tech-
nique is fully mono-compatible, making it especially useful
when recording sound for film, video, or broadcast.



)

=\
- St Link Modk {23
Use @ to select the input ere0 T Mot B
pair, and press @

Stereo Link
Stereo Link
Input 7/8 Stereo Link
Al 3

Input 3/4

Input 5/6

MENU : Return

HINT

Select ALL to set all input pairs at the same time.

Input 1/2

Stereo Link
+ MS Stereo Link

=
5. Use @ to select MS Stereo

Link, and press @

MENU : Return

Setting value Explanation

Stereo Link When stereo-linked, inputs are handled normally.

When stereo-linked, signals from a mid-side mic are con-

MS Stereo Link .
verted to ordinary stereo.

NOTE

e When S Stereo Link is selected, odd-numbered inputs are han-
dled as mid signals and even-numbered inputs as side signals.

e The MS Stereo Link setting is disabled if a ZOOM mic capsule
is connected that cannot have L/R signals routed individually to

inputs 1/2.

HINT

¥ for each input to adjust the mid/side balance.
e The PFL screen allows you to adjust the side mic level for inputs

1/2 when a mid-side mic capsule is connected.
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[Adiusting the input levels of multiple tracks simultaneously (Trim Link) ]

The input levels of multiple tracks can be linked and adjusted at the same time.

1 = Press .

=
Use @ to select INPUT, MENU

FINDER

META DATA (for
and press . THEUT
OUTPUT

REC
PLAY

e\
Use @ to select Trim Link, TNPUT

Phase Invert
and press @

Phantom

Plugin Power

Input Delay
Stereo Link Mode
Trim Link

MENU : R

MENU : Return

HINT

pressing (3] while pressing and holding [=].

You can also open the Trim Link screen from the Home Screen by

=)
4. Use @ to select a track to link, and press @

Group A

GrowpB @B

copCOOOOOOOO
Growpd IO OOOOO0O

All Tracks: [] Clear Clear all
RSN settings
Ml Linked
Not linked
HINT
* You can use ; § for the first track in a link group to adjust all the

input levels within that group at the same time.

¢ |cons for group names are shown next to linked tracks.

B0 & b |&zi/8|daB

Scene001-T001
-6 -1z -

m s
R
e o3 32 5 I Scene001-T00L

NOTE

® A track cannot be in more than one group at a time.

e The input levels of tracks set to MS Stereo Link will also be linked
if those tracks are put into groups.

e The input levels of tracks that have a mic capsule connected will
not be linked even if those tracks are put into groups.




[Adjusting the side level of a mid-side mic capsule (Side Mic Level) ]

You can adjust the side mic level (stereo width) before recording when a mid-side mic capsule is connected.

1 = Press for track 1 or 2.

=
2. Use @ to select Side Mic

Level, and press @

=\
3- Use @ to adjust the side
mic level, and press .

Track 1 : PFL

Input Limiter
Fader

Pan

Phase Invert
Side Mic Level

T

Side Mic Level

e

off
+0.0dB
Center

MENU : Return

HINT

This can be set to Off, RAW or in a range from -24 to +6 dB.

NOTE

* The more the side mic level is increased, the greater the stereo
width.

e When set to RAW, recording will occur without stereo encoding.
The stereo width of audio in RAW format can be adjusted after

recording by using ZOOM MS Decoder or other plug-in software.

HINT
When dual channel recording is on, the side mic level can also be

set for tracks 5/6, which correspond to tracks 1/2.

(1aA87 o1\ ©pIS) 8|nsded o1w 8pIS-pIW e 10 |8A8| 8pis 8yl Bunsnipy
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[ Setting signals sent to headphones (Headphone Routing)

You can set the type of signal sent to the headphone output to either prefader or postfader for each track.
You can also save 10 setting combinations (Setting 1 — Setting 10).

: Headphone Routing i
1 5- Useandto 123456 78 L RMIM2S1S2
= Press ' %DDDDDDDDDDDDB-&

AAAAAA-R

select the setting you want

Y All Tracks: [7] Prefader  MONO Mix:
MENU [d Postfader  AllClear:[ ]
2 = Use @ to select OUTPUT, to change.

FINDER

[« @ Settingl  [pp]
META DATA (for Next Take)
and press . INPUT NOTE

REC ® You can also press + to open the Headphone Routing
PLAY

screen.

* You can edit and save up to 10 signal settings.

=\ e Settings are saved automatically.
—
3. Use @ to select Headphone, - il .
Headphoe ¥ ; .
OZ?;)E;OOH:/OH » Continue to one of the following procedures.
and press @ gtﬁ:ﬁ t::y' Settingtherouting . ..., P97
Output Limiter Using mono headphoneoutput. .................... P98
MAIN OUT Routing > N . . . .
Monitoring mid-side stereo signals.................. P98

4 7 =
Headphone =
= Use @ to select Headphone
Alert Tone Level ~20dBFS
Routing, and press @




Setting the routing

6. Use @ to select the tracks/outputs for headphone

routing and press @

Mid-side stereo Headphone Routing (| ‘T’?:ES ’guaed tothe
itori . eft headphone
monterng R M1M25152 channel

Set tracks 1-8
to prefader
(deactivates MS)

1234
DEE]E]IEE]EE]DI»L

AAAAAA=R

Tracks routed to the
right headphone

i channel
All Tracks: [7] Prefader  MONO Mix:

Cycles options:
v P Postfader AllClear: [ J

e Change tracks 1-8 to
postfader (cancels others)

* Change L/R to postfader [4d] & Setting 1 =)

(cancels others) [A Prefader selected

e Change M1/M2 to E Postfad | q
postfader (cancels others) ostfader selecte

e Change S1/S2 to Z Off
postfader (cancels others)
(deactivates MS)

Mono mix
Clear all settings

* You cannot set L/R, MAIN OUT 1/2 or SUB OUT 1/2 to prefader.
e You cannot select the 1-8, L/R , MAIN OUT 1/2 and SUB OUT
1/2 tracks at the same time. Selecting one type will deselect the

other.

)

HINT

Press @ to cycle through the options:
Prefader — Postfader — Off.

7. Press .

(Bunnoy suoydpeaH) sauoydpeay o0} Juss s|eubis Buimeg
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[Setting signals sent to headphones (Headphone Routing) (continued) j

Using mono headphone output

6.

=)
. Headphone Routing @
Use @ to seIeCt MONO M]X, 3456 78L RMMISIS
DDE]DDDDDDDDDDD»L
AAAAANAATAAAAA>R
and press .

All Tracks: [7] Prefader  MONO Mbx:
[ Postfader  AllClear:[]

] & Settigl [

Press .

Monitoring mid-side stereo signals

Signals from a mid-side stereo mic can be converted to an
ordinary stereo signal for monitoring.

)
Headphene Routing i)
6- Use @ to select !,

345678 L RMIMISIS?
DDDDDDDE]DDDDDD—>L

BAAAAAAAAAAA AR
and press . 7

AlTracks: [7] Prefader  MONO Mix: []
[d Postfader  AllClear:[]

[ad] & Settigl  [pp]

7. Press .

NOTE

e This is disabled for stereo-linked tracks that have Stereo Link
Mode set to MS Stereo Link.

e This is only enabled for tracks that have a mid-side microphone
or mid-side mic capsule connected and the Side Mic Level set to
RAW.

e When mid-side stereo monitoring is enabled, the prefader tracks
will be routed automatically to the headphone channels, with the

odd-numbered to the left and the even-numbered to the right. In

this case, the routing cannot be changed manually.




[Outputting alerts through headphones (Alert Tone Level) ]

The volume can be adjusted for alerts output to headphones when, for example, recording starts and stops.

=
1 = Press . 5 = Use @ to adjust the Alert Tone Level

— volume, and press .
MENU
2 = Use @ to select OUTPUT,
FINDER
META DATA (for Next Take) MENU : Return
and press . TN

IREG HINT

PLAY e This can be set to Off or between —48 and -12 dBFS.
e When set to Off, no alerts will be output.

=\
3 QUTPUT
= Use to select Headphone, _ . When alerts sound Sound type

OZ;)E,:OOH:/OH Remaining battery low | 880Hz tone 4 times every 30 seconds

and press . Output Level Recording starts 1000Hz tone 1 time
iyt Dy Recording stops 880Hz tone 2 times
Qutput Limiter " " "
MAIN OUT Routing Recording not possible | 880Hz tone 3 times

Headphone 2.

e

)

4. Use to select Alert Tone | .
leadphone Routing »

Alert Tone Level -20dBFS
Level, and press @

MENU : Return

(|]ane7 auo] ua|y) ssuoydpeay ybnouayy susje BumndinQ
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[ Disabling outputs (Output On/Off) ]

using batteries.

1 = Press .

—=x
2. Use @ to select OUTPUT,

and press @

=
3- Use @ to select Qutput

On/0ff, and press @

(#O/uQ 1ndinQ) sindino Buigesiq
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By disabling outputs that you are not using, you can reduce power consumption and increase the length of operation time when

e
4. Use @ to select the

output, and press @

MENU

FINDER
META DATA (for Next Take)

HINT
Select ALL to set all outputs at the same time.

—x
5. Use @ to select 0ff,

and press @



[Setting the standard output level (Output Level)

The standard output level can be changed.

1.

2.

Press .

—x
Use @ to select OUTPUT,

and press @

=\
Use @ to select Output

Level, and press @

MENU
FINDER »
»
»

META DATA (for Next Take)
INPUT

REC

PLAY

OQUTPUT

Headphone
Qutput On/Off

Qutput Level »

Qutput Delay
Qutput Limiter
MAIN OUT Routing

=
Qutput T 23
4. Use @ to set the output P e =
MAIN OUT 1/2 Normal ¢-10dBV)
SUB OUT 1/2 Normal ¢-10dBV)
type, and press . ol b

MENU : Return

HINT

Select ALL to set all outputs at the same time.

e\
MAIN OUT 1/2 23
5- Use @ to set the standard o=

Mic (-40dBVY

output level, and press @

Setting value Explanation

Normal (-10dBV) | This sets the standard level to —10 dBV.

Mic (-40dBV) This sets the standard level to -40 dBV.

(19Ae7 1nd1nQ) |9A8| Ind1no paepuels ay) Bumes
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[Setting output levels

The MAIN OUT 1/2 and SUB OUT 1/2 levels can be changed.

1 = Open the mixer on the Home

Screen. (— P11)

—x
2 = Use @ to open the MAIN

OUT 1/2 and SUB OUT 1/2

settings screen.

00:00:00 54351
MAIN OUT 172 | SUB OUT

220
UT 1/2

[ on/0ff

On | On/Off

Level Normal Level  Noi

Limiter

Off Limiter
Scene001-T001

On
rmal
Off

e
oc

AN
0000 &5, =
3- Use @ to select a fader, _ METE
On/Qff  On Oon/Off  On
Level Normal Level Normal
Limiter  Off k] Limiter  Off
and press @ Scene001-T001
il

=)
4. Use @ to adjust the 0

On/Off  On On/Off

output level, and press @

On

Level Normal Level Mormal
Limiter  Off Limiter  Off

HINT

e This can be set to Mute or from -48.0 to +12.0 dB.
e You can also check and adjust various output settings on
MAIN OUT and SUB OUT setting screen.

the




[ Delaying output signals (Output Delay) ]

By delaying audio outputs, you can correct timing differences for signals input to other devices from the 8.

=x
1. Press - 4. Use @ to select the Py e

MAIN OUT 2 00Frames
output and ress . SUB OUT 1 0.0Frames
2 N put, P SUB OUT 2 00Frames
= Use to select OUTPUT, Al >
FINDER
META DATA (for Next Take) S i,
and press . T

[REC HINT
PLAY -
Select ALL to set all outputs at the same time.

3 @ QUTPUT —
. MAIN OUT 1
= Use to select Qutput Headohone 5. use @ to adjust the delay
@ Qutput OnfOFF
Qutput Level .
Delay, and press - T in frames, and press .

Output Limiter
MAIN OUT Routing

MENU : Return

HINT
This can be set from 0.0 to 10.0 frames.

NOTE

® The delay in milliseconds depends on the frame rate of the

selected timecode.

e When Sample Rate is set to 192kHz, Output Delay is disabled.

(Aejag indinQ) sjeubis indino BulAejaqg
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[ Output Limiter

Using a limiter on the output can protect devices connected to the output jacks.

HINT HINT
For details about the effect of the limiter, see "Input limiter". (= P.81) Select ALL to set all outputs at the same time.

1 = Press .

» Continue to one of the following procedures.

Jaywi] indinQ

Using the limiter.........ccoociviciiiiiiicie e P104

Setting the tyPe «eeiieeeee e P.105

2 R - Setting the threShold.......c.oecureeieeeeeeeeee et P105
. Use () tosetectourur, [ Setting the sRacktme 106
META DATA (for Next Take) Setting the release time........cccoccvvviveciiiec i P.106

and press @ INPUT SEHHNG INKS cvovevecvecvreiececee e eeeeeceeeeseeeesee s seesaenans P107

REC
PLAY

Using the limiter

=)
=\ 5 < > MAIN OUT 1/2 )
3 Use @ to select Output OUTPUT = Use to select On/Off, s OffD(
=
Headphone @ Type Hard Knee
Output On/Off Threshold - 2dBFS
o and press .
Limiter, and press @ . Output Level P Attack Time i
Output Delay Release Time 200ms

QOutput Limiter
MAIN OUT Routing

Link On
MENU : Return

P =
4- Use @ to Select the Qutput Limiter 6- Use @ to select On' o On/Off =

MAIN OUT 1/2

output, and press &l and press .

MENU : Return MENU : Return

104



Setting the type

=)
MAIN OUT 1/2 L
5- Use @ to select Type, “
On/Off Off
and preSS Threshold - 2dBFS
Attack Time 1ms

=\
6- Use @ to select the type, — 5% @

Release Time 200ms
Link. On

MENU : Return

Soft Knee
and press .

MENU : Return

Setting value

Explanation

Hard Knee

Only peaks that exceed the threshold are attenuated. There
is no effect below the threshold.

Soft Knee

The limiter gradually affects the output signal about 6 dB
below the threshold for a gentler effect.

Setting the threshold

This sets the level at which the limiter begins operating.

=)
5- Use @ to select Threshold, WAL 12
On/Off
Type
and press @
Attack Time

Release Time 200ms
Link On

MENU : Return

N
6- Use @ to adjust the Threshold

setting, and press .

MENU : Return

HINT

This can be set from —16 to -2 dBFS.

Jaywi7 indinQ
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[ output Limiter (continued)

Setting the attack time

This sets the amount of time until limiting starts after the out-
put signal exceeds the threshold.

)
5- Use @ to select Attack HANOUT 172 =
On/Off Off
Type Hard Knee
T-| me, and press @ i Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms
Link On

MENU : Return

Attack Time

=\
6- Use @ to adjust the time,
and press .

MENU : Return

Setting the release time

This sets the amount of time until limiting stops after the out-
put signal goes below the threshold.

=)
B. use @ to select Release wamouriz - 8
On/Off Off
Type Hard Knee
T-| me, and press @ i Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms

Link On
MENU : Return

Release Time

=N
6- Use @ to adjust the time,
and press .

MENU : Return

HINT

HINT

This can be set from 1 to 4 ms.

This can be set from 1 to 500 ms.




Setting links

The limiter can be linked or applied separately to MAIN OUT
1 and MAIN OUT 2, as well as to SUB OUT 1 and SUB OUT 2.

=)
5- Use @ to select Li nk, MAIN OUT 12 -
On/Off off
Type Hard Knee
and press @ . Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms
Link On

MENU : Return

—x
6- Use @ to select 0ff,

and press @

MENU : Return

Setting value Explanation
Off Separates limiter operation.
Links limiter operation. If the signal for either linked signal
On reaches the threshold, the limiter will operate on both
channels.

Jauwi indinQ
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[ Selecting signals sent to the main outputs (VIAIN OUT Routing)

You can send either prefader or postfader signals for each track to the main outputs.

Press .

—x
Use @ to select OUTPUT,

and press @

—x
Use @ to select MAIN OUT

Routing, and press @

MENU
FINDER
META DATA (for Next Take)
INPUT

QUTPUT »

REC
PLAY

QUTPUT

Headphone

Qutput On/Off
Qutput Level
Output Delay
Output Limiter

MAIN OUT Routing »

=\
Use @ to select the track for MAIN OUT 1 or MAIN

OUT 2 routing and press @

MAIN OUT Routing iz

12345
1 IDIDIDID M1
AAAAAAAALAL->M2

All Tracks: [] Clear
Prefader
LA Postfader

MENU : Return

Z Select prefader
E Select postfader

A ot

Tracks routed to MAIN OUT 1

Tracks routed to MAIN OUT 2

Clear all settings

Set tracks 1-8 to prefader

Switches option:

e Change tracks 1-8 to
postfader

e Change L/R tracks to
postfader

HINT

Prefader — Postfader — Off.

Press @ to cycle through the options:

NOTE

one type will deselect the other.

e Tracks 1-8 can be set to Prefader or Postfader.
e The L/R tracks can only be set to Postfader.

e Tracks 1-8 and L/R tracks cannot be set at the same time. Selecting

5 = Press .




[ Selecting signals sent to the sub outputs (SUB OUT Routing)

You send either prefader or postfader signals for each track to the sub outputs.

1 = Press .

=
2 = Use @ to select OUTPUT, M

FINDER

META DATA (for Next Take)
and press . IR

REC
PLAY

=)
QUTPUT
3- Use @ to select SUB OUT
Qutput On/Off
Qutput Level
Routing, and press . @i Dy
Output Limiter

MAIN OUT Routing

SUB OUT Routing »

—\
4. Use @ to select the track for SUB OUT 1 or SUB

OUT 2 routing and press @

SUB OUT Routing {2

3

123456781LR
1AL -=>S1
7] e o i )

All Tracks: [] Clear
Prefader
|4 Postfader

MENU : Return

Z Select prefader
E Select postfader

[A off

Tracks routed to SUB OUT 1

Tracks routed to SUB OUT 2

Clear all settings

Set tracks 1-8 to prefader

Switch options:

e Change tracks 1-8 to
postfader

e Change L/R tracks to
postfader

HINT

Press @ to cycle through the options:
Prefader — Postfader — Off.

NOTE

e Tracks 1-8 can be set to Prefader or Postfader.

e The L/R tracks can only be set to Postfader.

e Tracks 1-8 and L/R tracks cannot be set at the same time. Selecting

one type will deselect the other.

5 = Press .

(Bunnnoy 1NO gNS) sindino gns ayj 01 1uas sjeubis Bunos|eg
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[ Timecode overview

The F BB can input and output SMPTE timecode.

Timecode is time information written to data when recording video and audio. It is used for video

devices, and synchronization of audio and video.

Using timecode for editing

If video and audio data both have recorded timecode, align-
ing them to a timeline and synchronizing them together is
easy when using nonlinear editing software.

HINT

The F Bl uses a precision oscillator that generates timecode with

a high degree of accuracy (+/- 0.2 ppm, or approximately 0.5 frames

per 24 hours).

editing, control of other

ecode
0:10:00:00

00:10:00:00
N

00:10:03:00

Nonlinear editing software

Audio file



Connection examples

Connections like the following are possible, depending upon
the specific equipment being used with the 8.
Synchronizing with a video camera

The IF BB records with mic input and transmits timecode.
The IF B3 saves the timecode that it generates with the
audio data. The timecode received by the video camera is
recorded with the video data.

Inputting timecode

Timecode is transmitted from an external timecode generator.
Both the I B3 and the video camera receive timecode and
record it with their audio and video data.

The input timecode can also be used to synchronize the

I~ 8 audio clock.

Timecode

>

Timecode
generator

m

MBIAIBAO BPOJBWI |
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[Setting timecode functions

1 = Press .

—x
2. Use @ to select TIMNECODE,

and press @

3- Use @

to select Timecode,

and press @

Timecode mode
Internal timecode
Internal user bits
External timecode
External user bits

Jam button

Timecode

Mode: Int Free Run
Int TC: 00n01w21=24¢

Ubits:01 011500 FPS:30ND

Ext TC: 00n 03034529+

Ubits:00 000000 FPS:30ND

MENU :

[ Jam \

MENU

META DATA (for Next Take)
INPUT

QUTPUT

REC

PLAY

TIMECODE »
MENU : Return|

TIMECODE L

bC
Auto Rec Delay Time 00s

Start Timecode Restart Time

MENU : Return

Internal timecode
frame rate

External timecode
frame rate
Internal timecode
restart button

Return

» Continue to one of the following procedures.

Setting the Mode ... P113
Stopping timecode output when recording is stopped .P.114
Synchronizing audio clock with external timecode........ P115
Automatically enabling internal timecode when no

external timecode iS iNPUt........ccevviveiiriie i P115
Setting the user bits for internal timecode...................... P116
Setting the frame rate for internal timecode................... P117

Jamming internal timecode
Restarting internal timecode with a specified value ...... P118




Setting the mode

The timecode mode settings allow you to specify:

e Whether the IF B3 generates timecode or receives
external timecode

e Whether or not timecode continues running when not
recording

4.

e\
Use @ to select Mode,

and press @

A
Use @ to select Mode,

and press @

=\
Use @ to select the mode,

and press @

Timecode —

Mode: Int Free Run

Int TC: 00n20m 16512
Ubits:01011500 FPS:30ND
Ext TC: 00n01x07<08+¢
Ubits:0000 0000 FPS:30ND

MENU : Return

bC

Mode Int Free Run

Int Auto Mute Off

MENU : Return

Mode —

Off

Int Record Run
Int RTC Run
Ext

Ext Auto Rec

MENU : Return

Setting value

Explanation

Off

No timecode will be written to the recording file.
Timecode will not be output from the TIMECODE OUT
jack.

Int Free Run

Internal timecode will be generated regardless of the
recording mode.
The internal timecode can be set manually using the
following menu items:

¢ MENU >TIMECODE >Timecode > Jam

e MENU >TIMECODE >Timecode > Restart
Timecode will always be output from the TIMECODE OUT
jack.

Int Record Run

Internal timecode will be generated only when recording.
The internal timecode can be set manually using the
following menu items:

e MENU >TIMECODE >Timecode > Jam

e MENU >TIMECODE >Timecode > Restart
When switching from another mode, or when recording
stops, the internal timecode will stop at the last value.

Int RTC Run

Internal timecode will be generated regardless of the
recording mode.
In the following situations, the internal timecode will be
synchronized (jammed) with the RTC (internal clock):

e At startup

e When Date/Time (RTC) has changed (= P.18)

* When switching to this timecode mode
Timecode will always be output from the TIMECODE OUT
jack.

Ext

The internal timecode will chase the external timecode.
You can also enable the automatic generation of internal
timecode when there is no external timecode. (= P. 115)

suonouny 8pooswi} Bumesg
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[ Setting timecode functions (continued)

Setting value

Explanation

Ext Auto Rec

The internal timecode will chase the external timecode.
You can also enable the automatic generation of internal
timecode when there is no external timecode. (= P.115)
Recording starts automatically when external timecode
input is detected. Recording stops automatically when
external timecode stops.

Stopping timecode output when recording is stopped

You can set whether or not timecode is output from the
TIMECODE OUT jack when recording is stopped.

4.

)

Use @ to select Mode,

and press @

=)
Use @ to select Int Auto

Mute, and press @

B
Use @ to select On,
and press @

Timecode =

Mode’ Int Free Run

Int 06 20m 1612
Ubits:01 01 1500 FPS:30ND
Ext TC: 00r01x075 08+
Ubits:00000000 FPS:30ND

Jan

MENU : Return

oC
Mode Int Free Run
Int Auto Mute Off

MENU : Return

Int Auto Mute =)

bC

Off

MENU : Return

e Timecode will continue to be output when recording/playback is
paused.
e This cannot be set when Mode is set to Off, Ext or Ext Auto Rec.




Synchronizing audio clock with external timecode

)

4. Use @ to select Mode,

and press @

—x
5. Use @ to select Ext Audio

Clock Sync, and press @

6- Use to select On,

and press @

)

Timecode |

e

Mode: Int Free Run

Int TC: 00-2 2¢

Ubits:01011500 FPS:30ND

Ext TC: 00n01.07-08+
Ubits:00 000000 FPS:30ND

P

MENU : Return

Mode

Ext Audio Clock Sync
Ext Continuous

MENU : Return

Ext Audio Clock Sync -
Off

~ 0On

MENU : Return

e This cannot be set when Mode is set to Off, Int Free Run, Int
Record Run or Int RTC Run.

e When there is no external timecode, the internal audio clock is

enabled to preserve continuity.

Automatically enabling internal timecode when no

external timecode is input

You can enable the automatic generation of internal timecode
to preserve continuity when there is no external timecode.

P}

4. Use @ to select Mode,

and press @

=
5. Use @ to select Ext

Continuous, and press @

)

6- Use to select On,

and press @

Timecode "z

bC
Int TC: 00201612«
Ubits:01011500 FPS:30ND
Ext TC: 0001407508+
Ubits:00 000000 FPS:30ND

Jan

MENU : Return

Ext Continuous

MENU : Return

Ext Continuous —

Of f

~ On

MENU : Return

e This cannot be set when Mode is set to Off, Int Free Run, Int

Record Run or Int RTC Run.

suonouny 8pooswi} Bumesg
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[ Setting timecode functions (continued)

Setting the user bits for internal timecode Setting value Explanation

User bits are data that you can set to be included in the time- uu uu uu uu You can set these values as you like on the Edit screen.

The month, day and year are entered automatically in that

code. Up to 8 numbers (0-9) and letters (A-F) can be included. mm dd yy uu | order using the RTC setting. You can set the "uu" value as
Recording date information, for example, can be useful when you like on the Edit screen.
editing later. The, day, month and year are entered automatically in that

dd mm yy uu order using the RTC setting. You can set the "uu" value as
you like on the Edit screen.

Setting the user bits (Ubits) mode The year, month and day are entered automatically in that
yy mm dd uu order using the RTC setting. You can set the "uu" value as

you like on the Edit screen.
—
4. Use @ to select Ubits, and press @ HINT

Only "uu" items can be changed.
P
5- Use @ to select Mode,

and press @

suonouny apooswi} Bumesg

Setting user bits (Ubits)

=)
4. use @ to select Ubits, and press @

MENU : Return

2
= . [
6 = 5. Use @ to select Edit, =
= Use to select the mode, ve mm dd yy uu
+ mm dd yy uu an d press .
and press . dd mm yy uu
yy mm dd uu

MENU : Return

MENU : Return
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6. Edit the value.

mm  dd vy uu

. . e F L
= Editing operations o 0 1,0,

=~
Turn @

Move cursor or
change value:

Select parameter
to change:

MENU : Cancel
Press @
HINT

User bits can only consist of numbers from 0 to 9 and letters from
AtoF

7. When done changing the

)
setting, use @ to select

Enter, and press @

Setting the frame rate for internal timecode

—x
4. Use @ to select FPS,

and press @

[ Enter |

MENU : Cancel

Timecode

Mode: Int Free Run
Int TC: 00401x25-18¢

Ubits:01 011500 [FPS:30ND

Ext TC: 00n03.38+23+
Ubits:E0 000000 FPS:30ND

MENU : Return

=\
5. Use @ to select the frame
23976ND

24ND
rate, and press . &b
29.97ND

2997

+ 30ND

MENU : Return

Setting value Explanation

This is the most common frame rate used with HD cameras
and other high-definition video recording.The count is 0.1%
slower than the actual time.

23.976ND

This is the standard frame rate used for recording film.This

24ND
is also used with HD cameras.

This is the frame rate for PAL video. This is used for PAL

25ND
video, which is used in Europe and other regions.

This is a frame rate used for NTSC color video and HD
cameras. The count is 0.1% slower than the actual time. This
is used for NTSC video, which is used in Japan, the United
States and other countries.

29.97ND

This is an adjusted frame rate that uses drop frames to make
NTSC match the actual time. This is used with video for
broadcast that requires the actual time frame to be matched.

29.97D

This is used to synchronize sound with film that is being
transferred to NTSC video. This is the standard frame rate
used for black-and-white television in Japan, the United
States and other countries.

30ND

This rate is used for special applications. This synchronizes
30D with film sound to be transferred to NTSC using 29.97fps
drop frame.The count is 0.1% faster than the actual time.

NOTE

Matching frame rates must be set in advance on all connected

video and audio devices.

suonouny 8pooswi} Bumesg
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[ Setting timecode functions (continued) ]

Jamming internal timecode Restarting internal timecode with a specified value

Timecode input through the TIMECODE IN jack is used to set

suonouny apooswi} Bumesg

118

internal timecode.

Z—\
4. Use @ to select Jam,

and press @

Timecode

Mode: Int Free Run
Int TC: 00n0Ln21s24+¢

Ubits:01 011500 FPS:30ND

Ext TC: 00n03034<29¢

(Coam )

MENU : Return

Ubits(EO00 0000 FPS:30ND

4.

e\
Use @ to select Restart,

and press @

Set the restart value.
= Editing operations

Move cursor or
change value:

Turn @

Select parameter

to change: Press @
e
Use @ to select Restart,

and press @

Timecode

Mode: Int Free Run
Int TC: 00n01r33s24+

Ubits:01 01 1500 FPS:30ND
Ext TC: 00n03n 4629+

Ubits:E0 000000 FPS:30ND

Jam [ Restart |

MENU : Return

Restart

Int TC:
00n 00 » 12- 22+

Restart Time:

C00n 3 00n 00= 0D

MENU : Return

Restart
Int TC:
00» 00 » 24-
Restart Time:

00n 00m 00s

\ Restart |
MENU : Return




[Setting automatic timecode recording delay (Auto Rec Delay Time) ]

If set to record automatically when external timecode is received, unnecessary recording could occur when timecode is received
for a brief amount time. In order to prevent this, you can set the amount of time until recording starts after timecode is received.

P
1 = Press . 4_ Use @ to adjust the time, futo Rec Delay Time 1888

— and press .
2. Use @ to select TIMECODE, M

META DATA (for Next Take)

INPUT
and press . @z
REC
PLAY HINT
TIMECODE -
This can be set from 0.0 to 8.0 s.

MENU : Return

A ]
TIMECODE
3- Use @ to select Auto Rec >

Timecode »

Auto Rec Delay Time 00s
De 1 ay T.l me and press @ Start Timecode Restart Time

MENU : Return

(ewi] Aejag 98y 01ny) Aejep Buipiodal apodawil dilewoine Buimes
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[Setting how timecode is initialized at startup (StartTimecode) ]

Since internal timecode stops when the I 8 is turned off, the timecode is automatically initialized (jammed) during startup.
You can set the value that is used for jamming at that time.

Setting value Explanation
1 = Press - RestartTime When the FF B starts, the value set by Restart (— P.118)
is used to jam the internal timecode.
e\ When the (o = | starts, its timecode is restored from the
2 - Use @ to select TIMECODE MENU timecode when the power was turned off and advanced by
META DATA (for Next Take) RTC the elapsed time using the Date/Time (RTC) setting
INPUT
OUTPUT (= P18).
and press . REC Since RTC is less precise than internal timecode, discrep-
PLAY ancies will occur.
=)
TIMECODE )
3. Use @ to select Start .
imecode >
Auto Rec Delay Time 00s
Tinecode, and press @
r .

MENU : Return

(apooawi] pelS) dnuess e pazijeniul s| 8pooswil moy Buimes

Start Ti |
4. Use @ to set how o tmecoce oo

RTC
timecode is initialized,

and press @
MENU : Return
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[Slate mic and slate tone overview

When recording with the 8 you can add audio com-
ments that describe, for example, the scene being filmed or
the anticipated cuts. You can also record slate tone signals
that can be used to synchronize with video.

The IF B3 has a built-in slate mic for recording comments
and the ability to output a variable frequency tone signal.

HINT
A "slate" is a clapperboard used when recording video.

e The slate mic and slate tone cannot be used at the same time.

e The slate mic and slate tone cannot be used during audio file

playback.

MBIAIBAO BUO0] dle|S pue Jlw 31e|S

121



(91l @1e|S) O1w 818(S BY] YyUM Buipiooay

122

[ Recording with the slate mic (Slate Mic)

You can use the built-in slate mic to record comments and to keep notes about recorded takes.

1 = Press .

e\
zm)
2. Use @ to select SLATE, v
INPUT >
QUTPUT »
and press . G %
PLAY »
TIMECODE »

SLATE »

MENU : Return

SLATE

3 Slate Mi a
= Use to select Slate Mic,
>

Slate Tone
and press @

)

MENU : Return

» Continue to one of the following procedures.

Setting the volume ..o, P122
Setting the routing .....coceeeeeereree e P123
[T oToT o [ o Ve [ PRSPPIt P124
Disabling the slate MicC......cccccceiiiiiiiiiiie e P124

Setting the volume

=\
4. Use @ to select Level,

and press @

=\
5- Use @ to adjust the level,
and press .

Slate Mic

e

Level +0dB

Routing
On/Off

MENU : Return

HINT

This can be set from 0 to 24 dB.




)

Setting the routing

Set the destination for the slate mic signal. Routing to tracks 1-8 is not possible when operating the 8 s
4 \ an audio interface (Stereo Mix)
. Slate Mic == .
= Use @ to select Routing, -
HINT
and preSS @ On/Off On
Press @ to switch between Postfader and Off.

6- Press .

e
5 = Use @ to select the tracks/outputs for slate mic

signal routing and press @

(01Nl 818|S) 21W 91E|S BUY YUM BuIpI0daY

Al Tracks: [] Clear Clear all settings
L PostTader Set all to postfader

MENU : Return

E Select postfader

[ of
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[Recording with the slate mic (Slate Mic) (continued) ]

Recording Disabling the slate mic

l —
You can set the slate mic so that it will not be enabled if DO

4_ Press to start recording. is accidentally pushed left toward the mic symbol.

=
4. Use @ to select On/0ff, Saitlle

Level

5- Push left toward the mic symbol and release. Routing
and press @

On/Off

6. To disable the slate mic, push left toward the

mic symbol again and release.

B
On/Off
NOTE 5. use @ to select 0f f (

* When the slate mic is in use, other signals input to the tracks that on
it is routed to are muted. (Lock), and press @

e The slate mic signal is always routed to the headphone L/R chan-
nels regardless of other routing settings.

e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

(91l @1e|S) O1w 818(S BY] YyUM Buipiooay

HINT

If you push and hold left toward the mic symbol for two or

more seconds, the slate mic will be enabled until you release the

switch.
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[ Recording a slate tone (Slate Tone)

)

By adding a slate tone when the recording starts, aligning audio to video during editing will be easier.You can also use a slate

tone to coordinate levels with connected equipment.

1 = Press .
—x
2- Use @ to select SLATE, :

INPUT

QUTPUT
and press . IREG
PLAY

TIMECODE
SLATE »

MENU : Return

Py

(=0
3. Use @ to select Slate SHATE *

Slate Mic »
Tone, and press @

Slate Tone »

MENU : Return

» Continue to one of the following procedures.

Setting the volume .........oceveiiiiiiii e P125
Setting the freqUENCY .......ccoeiiiiiiiiieee e P.126
Setting the routing ......cccveeceee e P126
21T eTe] Lo [Ta Ve [P USR T PRN P127
Disabling the slate tone .......cccccovvveiiiiiiiniicc, P.128

Setting the volume

=
4- Use @ to select Level,

and press @

=)

5. Use @ to adjust the level,
and press .

Slate Tone —

Level -20dBFS

Fregency 1000Hz
Routing >

-20dBFS =

MENU : Return

HINT

This can be set from -20 to 0 dBFS.

(auo] 81e|G) BUO} B18|S B BUIpI0daY

125



(euo] o1e|S) BUO] B1e|S B BUIpI10day

126

[ Recording a slate tone (Slate Tone) (continued)

Setting the frequency

=)
=2
4. Use @ to select Frequency, State Tone =
Level -20dBFS
and press . Routing »

=
5- Use @ to adiUst the Fregency
frequency, and press .

1000Hz =

MENU : Return

HINT

This can be set from 100 to 10,000 Hz.

Setting the routing

Set the destination for the slate tone signal.

=)
4. use @ to select Routing, Safelore N
Level —20dBFS
Fregency 1000Hz
and press @
On/Off On

B
5 = Use @ to select the tracks/outputs for slate tone

signal routing and press @

12 3
Tone->[d [

All Tracks: [ ] Clear
Postfader

MENU : Return

Clear all settings
Set all to postfader

E Select postfader

A off

Routing to tracks 1-8 is not possible when operating the 8 s

an audio interface (Stereo Mix).




HINT

Press @ to switch between Postfader and Off.

6. Press .

Recording

4. Press to start recording.

5 = Push g) right toward the tone symbol and

release.

e When the slate tone is in use, other signals input to the tracks that
it is routed to are muted.

e The slate tone signal is always routed to the headphone L/R chan-
nels regardless of other routing settings.

e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

HINT

! —
If you push and hold right toward the tone symbol for one

or more seconds, the slate tone will be enabled until you push the

switch toward the tone symbol again.

(auo] 81e|G) BUO} B1B|S B BUIpI0dDY
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[ Recording a slate tone (Slate Tone) (continued)

Disabling the slate tone

You can set the slate tone so that it will not be enabled if
is accidentally pushed right toward the tone symbol.

=x
£ Use @ to select On/0ff, it Iz -

Level -20dBFS

Freqency 1000Hz
and press Routing N
On/Off on

e\
On/Off BE
O. use @ to select 0f

(Lock), and press @




[ Exchanging data with a computer (SD Card Reader) ]

By connecting the FB8iwa computer, you can check and copy data on SD cards.

Connecting to a computer

1 = Press .
—x
2- Use @ to select USB,

and press @

=
3. Use @ to select SD Card

Reader, and press @

PLAY »
TIMECODE »
SLATE »
»
»

SYSTEM
SD CARD

USB »

MENU : Return

UsB z

SD Card Reader »

Audio Inter face »
FRC-8 »

4. Connect the I 8 and computer with a USB cable.

NOTE

e The following operating systems are supported:
Windows: Windows 7 or later
Mac OS: Mac OS X (10.8 or later)

e The IF 8 cannot operate on USB bus power. Use the internal
batteries, the dedicated AC adapter or an external DC power sup-
ply to power it.

HINT
When the IFF B is connected to a computer, the SD cards loaded

in slots 1 and 2 are recognized as separate SD cards.

Disconnecting

1 = Disconnect on the computer.
Windows: Select = B from the “Safely Remove Hardware
and Eject Media” icon on the bottom of the computer screen.

Mac OS: Drag and drop the = 88 icon to the Trash.

Always follow correct computer disconnection procedures

before removing the USB cable.

2 = Disconnect the cable from the computer and the

B, and press .

(1opeay pied @s) 491ndw oo e yum eiep Buibueyoxy
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[ Using as an audio interface (Audio Interface)

-8 input signals can be input directly to a computer or an iOS device, and playback signals coming from a computer or an
iOS device can be output from the 8.

Connecting to a computer or an iOS device

1.

2.

Press .

—x
Use @ to select USB,

and press @

e\
Use @ to select Audio

Interface, and press @

=\
Use @ to select the mode

and connected device,

and press @

PLAY
TIMECODE
SLATE

SYSTEM
SD CARD
UsB 4

MENU : Return

SD Card Reader

Audio Interface »

FRC-8

Audio Interface L

bC

Stereo Mix (PC/Mac) »

Stereo Mix (iPad) >
Multi Track (PC/Mac) >

MENU : Return

Setting value Explanation
Stereo Mix This is a 2-in/2-out connection mode for Mac/Windows
(PC/Mac) and sends tracks 1-8 as a stereo mix.
Stereo Mix This is a 2-in/2-out connection mode for iOS devices
(iPad) and sends tracks 1-8 as a stereo mix.

This is an 8-in/4-out connection mode for Mac/Win-
dows and sends tracks 1-8 as separate signals (cannot

Multi Track
ui frac be used with an iOS device).

PC/M
( ac) A driver is necessary for use with Windows. Download

the driver from the ZOOM website (www.zoom.co.jp/).

5 = Use a USB cable to connect the = B3 and the

computer or iOS device.

NOTE

e A Lightning to USB Camera Adapter is necessary to connect an
iOS device.

o The F BB cannot operate on USB bus power. Use the internal
batteries, the dedicated AC adapter or an external DC power sup-
ply to power it.




Disconnecting

1.

2.

Press .

A
Use @ to select Exit, -

INPUT

»

OUTPUT »

and press @ LOOP BACK off
SLATE »

[231) »

MENU : Return

e\
Use @ to select Yes, B

Exit Audio Interface Mode.

Are you sure?
and press .

No

MENU : Return

Disconnect the cable from the computer or iOS device

and the F B3

(®0B4IB1U| OIPNY) 80BYBIUI OIpNE ue se Buisn
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[Audio interface block diagrams
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Audio interface block diagrams
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Audio interface block diagrams
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[Audio interface settings

The following settings can be made when using the IF B as an audio interface. See the relevant pages for details about

operation.

Setting loop back (Stereo Mix only)

This function allows the playback sound from the computer
or i0S device and the I B3 inputs to be mixed and sent
back to the computer or iOS device (loop back).

You can use this function to add narration to music played
back from the computer and record the mix or stream it from
the computer, for example.

1 = Press .

N
2. Use () toselect LOOP BACK, e

4
>

INPUT

QUTPUT

L OOP BACK O
and press @ SLATE

(241}

MENU : Return

L
to select On, LOOP BACK 2

3 = Use
off

and press .

)

MENU : Return

Mixing inputs

You can adjust the mix balance of input signals sent to the
computer or iOS device. When using Multitrack mode, the
individual inputs will be sent. When using Stereo Mix mode,
the mixed stereo signal will be sent.

. {120
1 = Open the mixer on the Home = USBAUDIOINLERFACE

Screen. (— P11)

Stereo Mix Mode
-6

—45 -20  -16  -12

2 = Adjust the parameter settings.

= Editing operations

=}
Move cursor or change value: Turn @

Select parameter to change:  Press @



F8 Multi Track Field Recorder

)

Parameter Setting range Explanation

Fader Mute, -48.0 - +12.0 dB | Adjusts the level of the input signal.

Adjusts the left-right stereo position of

Panning L100 - Center - R100 . .
the input signal.

HINT

e You can turn @ to move the cursor, and also adjust the settings
of the MAIN OUT 1/2 and SUB OUT 1/2 tracks.

e When a fader or pan knob is selected, press and hold @ to
reset it to its default value. If already set to its default value,

selecting a fader mutes the track.

&
@
=)
Q
e
(7]
oe}
=
(=
=
Q
=2
o
>
1)
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[ Using an FR(C-8 as a controller (Connect) ]

By connecting an FRC-8 to the 8, you can use it to adjust trim, fader and pan settings, for example.

1.

2.

Press .

—x
Use @ to select USB,
and press @

—x
Use @ to select FRC-8,

and press @

3
Use @ to select Connect,

and press @

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD

SD Card Reader
Audio Interface

FRC-8

Connect

User Key
Power Source
Keyboard Type

5 = Use a USB cable to connect the F 88 and

the FRC-8.

6. Turn the FRC-8 power ON.

e When disconnecting the FRC'8, select "Disconnect" before

unplugging the USB cable.
e An FRC'8 and F8 Control cannot be used at the same time.




[ Setting the type of keyboard connected to the FR(C-8 (Keyboard Type)

You can connect a PC keyboard to the FRC-8 and useiitto input characters.

Set the type of PC keyboard connected to the FRC-8.

1 = Press .

=
2 = Use @ to select USB,

PLAY

@ TIMECODE
SLATE
and press . oveTEM

SD CARD

USB »

3. Use @ to select FRC-8,

and press @

=
4. Use @ to select Keyboard

Type and press @

B3
5 = Use @ to select the type,

and press @

Disconnect
User Key
Power Source

Keyboard Type
LED Brightness
Firmware Version

Setting value Explanation
us Use for English-language keyboards.
JP Use for Japanese keyboards.

(8dA| pieogAsy|) 8= Y 4 a1 01 pe1osuuod pieogAsy jo adAy syl Bumes
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[ Setting user keys for the FR(C-8 (User Key)

You can assign functions to the FRC-8 user keys.

1.

2.

Press .

—x
Use @ to select USB,
and press @

=
Use @ to select FRC-8,

and press @

e
Use @ to select User Key,

and press @

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD
USB

Disconnect

User Key

Power Source
Keyboard Type
LED Brightness
Firmware Version

—~ User Key =m
5. Use @ to select the key to =
User 1 Slate Tone

which to assign a function,

and press @

=\
6. Use @ to select the

function to assign,

User 2 Mark

User 3 Clear Clip Indicator

None
Slate Mic

+ Slate Tone

Mark

Set Trim Link.
and press @ fold

Setting value

Explanation

None

No function is assigned.

Slate Mic Enable and disable the slate mic.
Slate Tone Generate and stop slate tones.

Add marks to WAV format takes during recording
Mark and playback.
SetTrim Link | Open the MENU > INPUT >Trim Link screen.
Hold Use to disable the keys set with "Key Hold Target".
Clear Clip Clear the level meter clipping indicators.
Indicator
Circled Circle the currently selected take.




[ Setting the power supply used by the FRC-8 (Power Source)

)

Set the DC power supply shutdown voltage, nominal voltage and type of batteries so that the remaining power supply charge
can be shown accurately. On this menu page, you can check the voltage of each power supply and the remaining battery capacity.

1.

Press .

e\
Use @ to select USB,
and press @

—x
Use @ to select FRC-8,
and press @

e

PLAY »
TIMECODE »
SLATE »
»
»

SYSTEM
SD CARD

USB » |

MENU : Return|

e
4. Use @ to select Power

Source, and press @

Disconnect

User Key

Power Source
Keyboard Type
LED Brightness
Firmware Version

Power settings for the FRC'8 are the same as for the
= B . See "Setting the power supply used" (= P.21).

NOTE

When multiple power supplies are connected, they will be used in

the following order of priority.
1. DC power supply (Ext DC)
2. AA batteries (Int AA)

The voltages of each power supply are shown on the display.

(891n0g Jamod) 8=y 4 8y1 Aq pasn Ajddns samod sy Buimes
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[ Setting the FR(C-8 LED brightness (LED Brightness)

=)
[
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Press .

—x
Use @ to select USB,
and press @

=
Use @ to select FRC-8,

and press @

e
Use @ to select LED

Brightness, and press @

You can adjust the brightness of the LEDs on the FRC-8.

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD
USB

Disconnect

User Key

Power Source
Keyboard Type
LED Brightness
Firmware Version

LED Brightness

—x
5. Use @ to adjust the
brightness, and press .

HINT

This can be set from 5 to 100.




[ Updating the FRC-8 firmware

You can check the FRC=8 firmware version and update it to the latest version.
The latest update file can be downloaded from the ZOOM website (www.zoom.co.jp).

1 = See "Using an FRC-8 as a controller" (—+P136), and

A
5- Use @ to select USB,
connect the F B3 and the FRC-8.
and press .

Updating is not possible if the remaining battery or DC power sup-
ply charge is low. In this case, replace the batteries with new ones

or use a charged DC power supply.

—x
6. Use to select FRC-8,

@

2 = Copy the update file to the root directory on an SD and press @

card.

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD

USB »

» Continue to one of the following procedures.

3- Load the SD card into the SD CARD 1 slot.

| If an SD card is loaded in the SD CARD 2 slot, eject it. |

4. Press .

Checking the firmware version .................... P142

NOTE Updating the firmware ... .. ..

.................... P142

atemuwiily 8=y 4 ay: Bunepdn
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[ Updating the FR(C-8 firmware (continued)

Checking the firmware version

=2 .
7- Use @ to select Fi rmware Disconnect
User Key
. Power Source
Versi on, and press . Keyboard Type
LED Brightness

Firmware Version »

System Version

Boot Version

Updating the firmware

3
7. Use @ to select Update o Koy

Power Source
. Reyboard Type
Firmware, and pr .
e , p ess LED Brightness
Firmware Version

Update Firmware »

Update Firmware

=3
8- Use @ to select Yes,
100->1.10

and press @ Are you sure?

Do not turn the power off, remove an SD card or disconnect the
USB cable during an update. Doing so could cause the FRC'G to

become unstartable.

Update Main System

9- After the update completes,

100-> 110

turn the FRC-B power off. Complete !

Please turn of f FRC-8.

MENU : Return



[Setting how timecode is shown (Home  Timecode Display Size) ]

You can change the size of the timecode display on the Home Screen.

=)

. Hi Tir de Display Si [C
1 = Press . 4. Use @ to select the size, . "‘“"‘* imecode Display Size ¢
Big
= and press .
=
2. Use @ to select SYSTEM, =
OUTPUT »
[HEC D MENU : Return
and press . IFLGSY D
TIMECODE 3
SLATE 3

Setting value Explanation

MENU : Return The timecode is small and the time counter is large.

— Il 000:0 00:00:16:
3 = Use @ to select Home DaterT SYSTEM - The timecode is large and the time counter is small.
ate/Time (RTC) » y
= 00003 /22 G =
T-Imecode D-lsp'lay S-ize’ Auto Power OFf On o . - . DC

Home Timecode Display Size Small

Level Meter »
LED Brightness 100
and press @ 3
MENU : Return

(9z15 Ae|dsig @pooawi] dWOH) umoys si 9podawi} moy Bunieg
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[ Setting level meter appearance (Level Meter)

You

1.

2.

can set how the level meters appear on the display.

Press .

Z—\
=0
Use @ to select SYSTEM, m
QUTPUT »
REC »
and press . [FLGRY %
TIMECODE »
SLATE >

SYSTEM >

MENU : Return

=2 S
SYSTEM 20
Use @ to seIeCt LeV ¢ 1 Date/Time (RTC) >
Power Source 4
Auto Power Off On
Me t € r’ a nd press @ ) Home Timecode Display Size Small

Level Meter 4
LED Brightness 100

MENU : Return

» Continue to one of the following procedures.

Settingthetype........ ... i P144
Setting the peak holdtime . ....................... P145
Setting the level meter resolution.................. P146
Setting which track level meters are shown

ontheHome Screen . ........ .. ... .. ... P146
Showing track names on level meters .............. P147
Setting the level meter reference................... P147

Setting the type

You can set whether the level meters use VU or Peak style.

4.

=
Use @ to select Type,

and press @

B
Use @ to select the type,

and press @

Level Meter =)

bC
Type Peak Only
Peak Hold Time 2sec
Resolution Segment
Level Meter View >
Track Name View Off
Reference Level Normal Level

MENU : Return

e

+ Peak Only

Peak + VU
VU Only

MENU : Return




Setting value

Explanation

T ——_——;

Peak Only —45 =20 -1g -12
The actual peak level of the signal (dBFS) is shown
1 IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
-30 _-20 s 1] 20
Peak +VU Both VU and peak level are shown simultaneously. In this
mode, the bars function as a VU meter except for the right-
most bar, which shows the peak level.
1 IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
VU Only -30 =20 -10 20

This display style is close to human hearing.

Setting the peak hold time
=)
A. use( ) toselect Peak Hold

Time, and press @

—x
5- Use @ to adjust the peak

hold time, and press @

Level Meter {zzm)

Type Peak Only
Peak Hold Time 2sec
Resolution Segment
Level Meter View »
Track Name View Off

Reference Level Normal Level

MENU : Return

Peak Hold Time -

MENU : Return

(421817 |9A97) @oueleadde Ja1ow |aA8| Buimes
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[ Setting level meter appearance (Level Meter) (continued)

Setting the level meter resolution
)
4- Use @ to select

Resolution, and press @

e
Use @ to select the

resolution, and press @

Level Meter —

Type Peak Only
Peak Hold Time 2sec
Segment

Resolution
Level Meter View »
Track Name View Off

Reference Level Normal Level

MENU : Return

Resolution —

Solid

MENU : Return

Setting value Explanation
T
Segment -30 =20 -10 i 8
(Shown when set to VU Only)
Solid
(Shown when set to VU Only)

Setting which track level meters are shown on the

Home Screen

You can change which tracks are shown on the Home Screen.

—x
4. Use @ to select Level

Meter View, then Viewl —

Viewd, and press @

=\
5 = Use @ to select tracks to

show, and press @

Level Meter View L]

e

View2
View3
Viewd

MENU : Return

e

Track 1/2

Track 3/4
Track 5/6
Track 7/8
Track L/R
MAIN OUT 1/2

MENU : Return

HINT

will appear on the Home Screen.

Multiple tracks can be shown. Not showing any tracks is also pos-

sible. If none of the check boxes are checked, no track level meters

6- Press .



Showing track names on level meters

e\ =
Level Met
4. use @ to select Track Name B

View, and press @

A
5- Use @ to select On,

and press @

Type Peak Only
Peak Hold Time 2sec

Resolution Segment

Level Meter View »
Track Name View Off
Reference Level Normal Level

MENU : Return

MENU : Return

Setting value

Explanation

Off

The track names are not shown
on the level meters.

W 0000000 i

The track names set with the
On "Track Name" setting (— P. 48)
are shown on the level meters.

Setting the level meter reference

Z—\
4. Use @ to select Reference

Level, and press @

=
5- Use @ to select the

reference level setting,

and press @

Level Meter 'z

bC

Type Peak Only
Peak Hold Time 2sec
Resolution Segment

Level Meter View 4
Track Name View Off

Reference Level Normal Level

MENU : Return

Reference Level —

~ Normal Level

Low Level

(421817 |9A97) @oueleadde Ja1ow |aA8| Buimes
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[Setting level meter appearance (Level Meter) (continued)

Setting value

Explanation

When level meter type is
Peak Only

When level meter type is
Peak +VU orVU Only

Normal Level

The center of the level
meter is -12 dBFS. Clear
monitoring  of
higher than -12 dBFS is

possible.

levels

The center of the level meter
is 0 VU (-20 dBFS). Clear mon-
itoring of levels higher than 0
VU (-20 dBFS) is possible.

Low Level

The center of the level
meter is -20 dBFS. Clear
monitoring  of
lower than -20 dBFS is

levels

possible.

The center of the level meter is
-10 VU (-30 dBFS). Clear moni-
toring of levels lower than -10
VU (-30 dBFS) is possible.




[Setting the LED brightness (LED Brightness)

You can adjust the brightness of the LED level meters on the front of the 8.

1 = Press .
—x
2. Use @ to select SYSTEM,

and press @

—x
3- Use @ to select LED

Brightness, and press @

e

OUTPUT »
REC »
PLAY »
TIMECODE »
SLATE »

SYSTEM »

MENU : Return

SYSTEM )|

oc
Date/Time (RTC)

Power Source
Auto Power Off On
Home Timecode Display Size Small
Level Meter »
LED Brightness 100

MENU : Return

»
»

LED Brightness

=
4. Use @ to adjust the
brightness, and press .

MENU : Return

HINT

This can be set from 5 to 100.

(sseulyblg @37) sseurybrg @37 eyl bumas
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[ Making display settings (LCD)

You can make settings related to the display.

Setting the display brightness

=)
4. Use @ to select

1 = Press .

(@d1) sbumes Aejdsip Bunjey

P Brightness
[ Power Saving  On (Low-Backlight)
2 Use @ to select SYSTEM, = :
- 3 Brightness, and press . iy e @iy
»
and press @ D |
TIMECODE »
SLATE » MENU : Return
MENU : Return
o)
. Bright:
5- Use @ to adjust the e
=2
SYSTEM i
3 Use @ to select LCD, = .
" Power Source » brightness, and press .
Auto Power Off On
and press . Home Timecode Display Size Small
Level Meter >

LED Brightness 100
LCD >

MENU : Return HINT

MENU : Return

This can be set from 5 to 100.

» Continue to one of the following procedures.

Setting the display brightness..........ccccocoviiiiiiiiiniinen. P.150
Changing the display backlight setting.............ccceeuenee. P151
Making the display easier to read under bright light.....R151
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Changing the display backlight setting

You can set the display backlight to dim after 30 seconds

without use.

A
4- Use @ to select Power

Saving, and press @

Py

5. Use @ to select the

setting, and press @

LCD

Brightness 100
Power Saving  On (Low-Backlight)
Outdoor Mode Off

e

MENU : Return

Power Saving =

Off

+ On (Low-Backlight)

On (Backlight-Of f)

MENU : Return

Setting value Explanation
off The backlight brightness does not change even
after time passes without use.
On (Low-Backlight) The backlight dims after time without use.
On (Backlight-Off) The backlight turns off after time without use.

Making the display easier to read under bright light

The display can be set to be easier to read in bright environ-
ments including in sunlight.

=) —
LCD —
4. use @ to select Outdoor .
rightness 100
Power Saving On (Low-Backlight)
Hode, and press @

MENU : Return

)

Qutdoor Mod
5. use @ to select On, T =
Off
and press .

MENU : Return

(@27) sbumes Aejdsip Bupiepy
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[ Adding marks when pausing (PLAY Key Option)

You can set how marks are added when is pressed while recording or playing back a WAV format file.

Setting how marks are added when recording

1 = Press .

=)
. PLAY Key Opti =
4. Use @ to select Recording, il =
N — Playing Pause Only
2. Use @ to select SYSTEM, o and press .
QUTPUT »
REC »
and press . [RLENY D
TIMECODE 4 MENU : Return
SLATE >
MENU : Return =)
R i
5 = Use @ to select how et
Pause Only
AN ST Pause & Mark
3. Use () toselect PLAY Key : marks are added, and
Auto Power Off

Home Timecode Display Size Small @
: Level Meter 4
Option, and press @ . Lt rightocss o press .

MENU : Return
LCD »

PLAY Key Option »

MENU : Return

(uondQ Aay Av1d) Buisned uaym syiew Buippy

» Continue to one of the following procedures. Setting value Explanation
Setting how marks are added when recording............... P152 Pause Only Pressing will pause without adding a mark.
Setting how marks are added when playing .................. P153 Pause & Mark Pressing will pause and add a mark.
Mark Only Pressing will add a mark without pausing.
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Setting how marks are added when playing

)
4. Use @ to select Playing,

and press @

=)
5- Use @ to select how

marks are added, and

press @

PLAY Key Option {120

oC

Recording Pause Only

Playing Pause Only

MENU : Return

Playing —
+ Pause Only
Pause & Mark
Mark Only

MENU : Return

Setting value Explanation
Pause Only Pressing will pause without adding a mark.
Pause & Mark Pressing will pause and add a mark.
Mark Only Pressing will add a mark without pausing.

(uondQ Aay AV1d) Buisned uaym syuew Buippy
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( Setting the keys held (Key Hold Target) )

Use the hold function to prevent misoperation during recording. Press + (8] to turn it on/off.
Follow these instructions to set which keys are disabled by the hold function.

—
1. Press [ve). 4. use @ to select the keys Lo B

[@JPFL1-8
held, and press @ (@] Trim Knob 1

Trim Knob 2
Trim Knob 3
Trim Knob 4

—x
2 = Use @ to select SYSTEN, TP

REC
PLAY
and press @ TIMECODE

SLATE

HINT
EENCERe D You can select Track 1-8, PFL 1-8, Trim Knob 1-8, Slate Mic, Slate

Tone, Encoder, MENU, HP Volume, REW, STOP, FF, PLAY and REC.

Level Meter

LED Brightness
Target, and press o
get, P . PLAY Key Option = Press .

Trim Knob Option

Key Hold Target »

MENU : Return|

B3
3- Use @ to select Key Hold S

(10B1e] pjoH AdY|) play sAey ay) Buies

HINT

e Even when hold is on for "STOP" and "Track1-8", you can press
+ [8 to turn the hold function off.
e QOperation using the FIRC -8 and F8 Control is possible

even when the hold function is on.
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[Checking SD card information (Information)

You can check the size and free space of SD cards.

1 = Press .

=
2. Use @ to select SD CARD, e

PLAY
and press . TIMECODE
SLATE

SYSTEM

e

»
»
»
»
4

SD CARD »

MENU : Return

3.

=)
Use @ to select
Information

Performance Test

Information, and press @ Format

Information
Volume label SD1:F8_SD1 Free:
Size:

Remain:

SD2:F8_Sh2 Free: 182GB
Size: 1.84GB
Remain: 003h47

MENU : Return

MENU : Return

Free space
Size

Remaining
recordable
time

(uonewuoyu|) uonewloul pies qs bunpsy)
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[Testing SD card performance (Performance Test)

You can test whether an SD card can be used with the I E3.The Quick Test is basic, and the Full Test checks the entire SD card.

Y

Press .
—=x
2. Use @ to select SD CARD,

and press @

=
3- Use @ to select

Performance Test,

and press @

—x
4- Use @ to select the SD

card to test, and press @

REC »
PLAY »
TIMECODE >
>
»

SLATE
SYSTEM
SD CARD >

MENU : Return

SD CARD L

bC

Information >

Performance Test >

Format >

MENU : Return

Performance Test )

bC

SD1 >

SD2 >

MENU : Return

Conducting a quick test.........cc.cceeueet
Conducting a full test........cccceeeeenes

Conducting a quick test

5.

=)
Use @ to select Quick

Test, and press @

3
Use @ to select Yes,

and press @

The card performance test will
start. The test should take about
30 seconds.

» Continue to one of the following procedures.

................................. P.156
................................. P157

Quick Test
Full Test

MENU : Return

Quick Test

Execute Quick Test.
Are you sure?

Yes No

MENU : Return



8.

The test completes.

The result of the evaluation will

be shown.

Press to stop the test.

Performance Test 2.

Result : OK
50%.

MENU : Return

Even if a performance test result is "OK", there is no guarantee

that writing errors will not occur. This information is just to provide

guidance.

Conducting a full test

Y
5. Use©to select Full Test,

and press @

The amount of time required for
the full test will be shown.

=
6- Use @ to select Yes,

and press @

7. The test completes.

The result of the evaluation will

be shown.

If the access rate MAX reaches
100%, the card will fail (NG).

Quick Test
Full Test

MENU : Return

Full Test

Execute Full Test.
Are you sure?
(Estimated Time : Oh 14m )

Yes No

MENU : Return

Performance Test =)

Result : OK
50%

Access Rate
Average: 11% Max: 11%
MENU : Return

(1s8] ®OUBWIONBY) 8oUBWIONEd pied g Bunss|
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[Testing SD card performance (Performance Test) (continued)

8. Press to stop the test.

* You can press to pause and resume the test.

e Even if a performance test result is "OK", there is no guar-
antee that writing errors will not occur. This information is

just to provide guidance.




[ Formatting SD cards (Format)

SD cards must be formatted for use with the I B3.

1.

2.

Press .

=
Use @ to select SD CARD,

and press @

A
Use @ to select Format,

and press @

P
Use @ to select the card to

initialize, and press @

REC

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD

MENU : Return

SD CARD L]

D

Information

»
»

Performance Test
Format »

MENU : Return

MENU : Return

5- Use

O

to select Yes,

and press @

NOTE

SD1

Format SD Card.
Are you sure?

No

MENU : Return

e Before using SD cards that have just been purchased or that have

been formatted by a computer, they must be formatted by the

8.

e Be aware that all data previously saved on an SD card will be

deleted when it is formatted.

(rewo4) spied s Bumewo
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[ Checking the — 8} Shortcut List

The IF BB has a shortcut feature that allows quick access to various functions.
See the “List of shortcuts” (= P. 173) for information about the shortcut functions.

1 = Press .

=x
2 = Use @ to select SYSTEM, MENU

OUTPUT

REC
and press . Al
TIMECODE

SLATE
SYSTEM »

: Return

1s17 1inouoys B = Y1 Bunpay)y

e\
3. Use @ to select Shortcut Level Meter

LED Brightness
3 LCD
Lis t' and press @ ' PLAY Key Option

Trim Knob Option
Shortcu

Shorteut List

bC
Display Next Take STOP (hold)
Scene Increment STOP + FF
False Take REW (hold)
User Scene Name Edit STOP + Tr1
Track Name Edit STOP + Tr2
Set Trim Link. STOP +Tr3

MENU : Return|
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[ Backing up and loading — 8} settings (Backup/Load Settings)

f~ B8 settings can be backed up to and loaded from SD cards.

1.

e\
2- Use @ to select SYSTEM,

Press .

and press @

=\
Use @ to select

Backup/Load Settings,

and press @

—x
Use @ to select the SD

card to use for backup/

loading, and press @

QUTPUT
REC
PLAY

TIMECODE
SLATE

SYSTEM
LCD
PLAY Key Option
Trim Knob Option
Key Hold Target
Shortcut List

Backup/Load Settings »

MENU : Return|

Backup/Load Settings  1EE]

e

SD2 »

P Continue to one of the following procedures.

Backingup ... e P161
Loading. . ... P162
Backing up

This saves a backup file to the "F8_SETTINGS" folder in the
root directory of the SD card.

=)
[
5. Use @ to select Backup > g
Backup >

Load/Delete >

and press @

6. Edit the name of the file

saved.

See "Character input screen”
(= P13) for how to input
characters.

MENU : Cancel

HINT

The extension of the saved backup file is ".ZSF".

(sBumag peo/dnyoeg) sbuies B = Buipeo| pue dn Buppeg
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[ Backing up and loading [~ B} settings (Backup/Load Settings) (continued)

Loading

You can load a backup file that is saved in the "F8_SETTINGS"
folder in the root directory of the SD card.

5- Use @ to select Load/

Delete, and press @

P
6 = Use @ to select the file to

load, and press @

Backup
Load/Delete

Load/Delete 2w

be

- Date: 16/09/16j
F8_Settings_16091 Ti 17:10:21]

ime!
F8_Settings_1609...

ENC thold) : Delete

HINT

completely erase its data.

You can press and hold @ to delete a file. Deleting a file will

e\
7. Use @ to select Yes,

Are you sure?
and press .




[ Restoring default setting values (Factory Reset) j

You can restore the factory default settings.

1 = Press .

=\
=3
2. Use @ to select SYSTEN,
QUTPUT 13
REC »
and press . IFLERY D
TIMECODE »
SLATE >

SYSTEM »

MENU : Return

)
3 SYSTEM
= Use @ to select Factory LAY Key Option
Trim Knob Option
Key Hold Target
Res Et’ and press @ ' Shorteut List

Backup/Load Settings
Factory Reset

=)
4. Use @ to select Yes' Factory Reset

Reset all settings.

Are you sure?
and press .

No

The settings will be reset and the
power will automatically turn off.

Input volume knob settings will not be reset.

MENU : Return

(1osay Ai0yoe4) sanjen Buies yneyop Buuolsay
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[ Checking the firmware version (Firmware Version)

You can check the firmware version.

1 = Press .

—x
Use @ to select SYSTEM,

and press @

2.

=
Use @ to select Firmware

Version, and press @

BC

QUTPUT

4
REC »
PLAY »
TIMECODE »
SLATE »

SYSTEM »

MENU : Return

SYSTEM

Trim Knob Option

Key Hold Target
Shortcut List
Backup/Load Settings
Factory Reset

Firmware Version >

MENU : Return

Firmware Version L

System Version : L00
Boot Version : 100

Subsystem Version @ 1.00

MENU : Return



[ Updating the firmware

The IF BB firmware can be updated to the latest version.

When an update is available, the file for the latest version can be downloaded from the ZOOM website (www.zoom.co.jp).

1 = Install new batteries in the = B3 or connect the

dedicated AC adapter to the DC IN connector.

NOTE

Upgrading the firmware is not possible if the remaining battery
power is low. In this case, replace the batteries with new ones or
use the adapter.

2 = On your computer, copy the file for updating to the

root directory on an SD card.

3- Load the SD card into the SD CARD 1 slot, and turn

the power on while pressing .

NOTE
[If an SD card is loaded in the SD CARD 2 slot, eject it first. |

Update Systems

)
4. Use @ to select Yes,

and press @

1.00->110

Are you sure?

Do not turn the power off or remove the SD card during an update.

Doing so could cause the I~ 8 t0 become unstartable.

Update Systems

5 = After the update completes,
100->1.10
turn the power off. Complete!

Please power off.

alemuully ay) Bunepdn
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[ Troubleshooting

If you think that the 8 operating incorrectly, check the following items first.

Recording/playback trouble

¢ There is no sound or output is very quiet

- Check the connections to your monitoring system and its volume
setting.

- Confirm that the volume of the = BB is not too low. (= P74)

+ No sound from connected equipment or inputs or it is very quiet

- If you are using a mic capsule, confirm that it is oriented correctly.

- Check the input level settings. (= P27)

- If a CD player or other device is connected to an input jack, raise the
output level of that device.

- Check the input signal monitoring settings. (— P74)

- Check the phantom power and plug-in power settings. (= P87 RP90)

- Check the headphone, MAIN OUT 1/2 and SUB OUT 1/2 routing
settings. (= P96, R108-109)

¢ Recording is not possible

- Confirm that track keys are lit red.

- Confirm that the SD card has free space. (= P155)

- Confirm that an SD card is loaded properly in a card slot.

- If “Card Protected!” appears on the display, the SD card write-
protection is enabled. Slide the lock switch on the SD card to disable
write-protection.

¢ The recorded sound cannot be heard or is very quiet
- Confirm that the volume levels of the tracks are not too low. (— RP51)
- Confirm that track keys are lit green during playback.

Other trouble

¢ Computer does not recognize the =8 cven though it is con-

nected to the USB port

- Confirm that the operating system is compatible. (= P129)

- The operation mode must be set on the 8 o allow the computer
to recognize the =8 - ri30

+ Battery operation time is short

Making the following settings increase the battery operation time.

- Set the power supply used correctly. (= R21)

- Turn unnecessary tracks off. (= P26)

- Turn unnecessary outputs off. (= P100)

- Set the phantom power voltage to 24V. (— P88)

- Disable phantom power during playback. (= P89)

- Turn timecode off if not using it. (— P113)

- Reduce the LED brightness.(— P149)

- Reduce the display brightness. (= P150)

- Set the display to dim when not used for some time. (= P151)

- Reduce the sampling rate used to record files. (= P29)

- Due to their characteristics, using nickel metal hydride batteries
(especially high-capacity ones) or lithium batteries should enable longer
use than alkaline batteries.
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[ Detailed product diagrams (continued)

Routing
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[ Metadata list

Metadata contained in BEXT chunks in WAV files

Tag Explanation Remarks
SPEED= Frame rate MENU >TIMECODE >Timecode > FPS
TAKE= Take number
UBITS= User bits MENU >TIMECODE >Timecode > Ubits
MENU > META DATA (for NextTake) > Scene Name Mode
SCENE= Scene name MENU > META DATA (f.or Next Take) > Us«.er Scene Name
MENU > FINDER > Option >Meta Data Edit > Scene
MENU > FINDER > Option > Rename
. L MENU > FINDER (Recording destination folder name)
TAPE= Name of recording destination folder | o\, _ FINDER > Option > Meta Data Edit > Folder (Tape) Name
CIRCLED= Circled take MENU > FINDER > Option > Meta Data Edit > Circle
TRL= Left track name
TRR= Right track name
TR1= Track 1 name
TR2= Track 2 name Track names are written as follows.
TR3= Track 3 name TRL = left track, TRR = right track
TR4= Track 4 name TR1 =track 1,TR2 = track 2...TR8 = track 8
TR5= Track 5 name During dual channel recording, tracks 1-4 are written to tracks 5-8.
TR6= Track 6 name
TR7= Track 7 name
TR8= Track 8 name
MENU > META DATA (for NextTake) > Note
NOTE= Take note MENU > FINDER > Option > Meta Data Edit > Note

181| elepeIsN

169



[ Metadata list (continued)

>
| Metadata contained in iXML chunks in WAV files
;‘)—. iXML master tag iXML sub tag Written | Read Remarks
® MENU > FINDER (SD card root folder)
<PROJECT> o o MENU > FINDER > Option > Meta Data Edit > Project
Name
MENU > META DATA (for NextTake) > Scene Name Mode
MENU > META DATA (for NextTake) > User Scene Name
<SCENE> o o . .
MENU > FINDER > Option > Meta Data Edit > Scene
= MENU > FINDER > Option > Rename
2’: <TAKE> . o MENU > FINDER > Option > Meta Data Edit >Take
= MENU > FINDER > Option > Rename
E MENU > FINDER (recording destination folder name)
<TAPE> o o MENU > FINDER > Option > Meta Data Edit > Folder
(Tape) Name
<CIRCLED> o o MENU > FINDER > Option > Meta Data Edit > Circle
<WILDTRACK> x x
<FALSE START> X X
<NO GOOD> X X
<FILE_UID> o x
<UBITS> o X MENU >TIMECODE >Timecode > Ubits
MENU > META DATA (for NextTake) > Note
<NOTE> o o . )
MENU > FINDER > Option > Meta Data Edit > Note
<BEXT>
<USER>
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iXML master tag iXML sub tag Written | Read Remarks
<SPEED>
<SPEED> | <NOTE> o X
<SPEED> | <MASTER_SPEED> o o MENU >TIMECODE >Timecode > FPS
<SPEED> | <CURRENT_SPEED> o x MENU >TIMECODE >Timecode > FPS
<SPEED> | <TIMECODE_RATE> o X MENU >TIMECODE >Timecode > FPS
<SPEED> | <TIMECODE_FLAG> o x MENU >TIMECODE >Timecode > FPS
<SPEED> | <FILE_SAMPLE_RATE> o X MENU > REC > Sample Rate
<SPEED> | <AUDIO_BIT_DEPTH> o X MENU > REC > WAV Bit Depth
<SPEED> | <DIGITIZER_SAMPLE_RATE> o X MENU > REC > Sample Rate
<SPEED> | <TIMESTAMP_SAMPLES_SINCE_MIDNIGHT_HI> o X
<SPEED> | <TIMESTAMP_SAMPLES_SINCE_MIDNIGHT_LO> o X
<SPEED> | <TIMESTAMP_SAMPLE_RATE> o X MENU > REC > Sample Rate
iXML master tag iXML sub tag Written | Read Remarks
<SYNC_POINT_LIST>
<SYNC_POINT> | <SYNC_POINT_TYPE> x X
<SYNC_POINT> | <SYNC_POINT_FUNCTION> x x
<SYNC_POINT> | <SYNC_POINT_COMMENT> X X
<SYNC_POINT> [ <SYNC_POINT_LOW> X X
<SYNC_POINT> | <SYNC_POINT_HIGH> X X
<SYNC_POINT> | <SYNC_POINT_EVENT_DURATION> x x
iXML master tag iXML sub tag Written | Read Remarks
<HISTORY>
<HISTORY> | <ORIGINAL_FILENAME> o
<HISTORY> | <PARENT_FILENAME> X
<HISTORY> | <PARENT_UID>
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[ Metadata list (continued)

>
§ iXML master tag iXML sub tag Written | Read Remarks
| [<FILE_SET>
§ <FILE_SET> | <TOTAL_FILES> o x
<FILE_SET> | <FAMILY_UID> o X
<FILE_SET> | <FAMILY_NAME> x x
<FILE_SET> | <FILE_SET_START_TIME_HI> X x
<FILE_SET> | <FILE_SET_START_TIME_LO> X x
<FILE_SET> | <FILE_SET_INDEX> o x
z
a
% iXML master tag iXML sub tag Written | Read Remarks
@ <TRACK_LIST>
<TRACK_LIST> | <TRACK_COUNT> o X
<TRACK> | <CHANNEL_INDEX> o x
<TRACK> | <INTERLEAVE_INDEX> o x
MENU > META DATA (for NextTake) >Track Name
<TRACK> | <NAME> o o MENU > FINDER > Option > Meta Data Edit >Track
Name
<TRACK> | <FUNCTION> X X
o=YESx =NO
Metadata and ID3 fields contained in MP3 files
Metadata ID3 field Format
Timecode Artist Name TC=[HH:MM:SS:FF]
Scene name, take number TrackTitle SC=[scene name] TK=[take number]
Frame rate, file length (time) AlbumTitle FR=[frame rate] D=[file length (time)]
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[ List of shortcuts

Home Screen

Shortcut

Explanation

Press and hold (=]

Show the name that will be given to the next
take recorded.
Example: Scene001-T002

CJ+[1

Advance the scene number by 1 (when the
Home Screen is open).

Press and hold

Move the previously recorded take to the
FALSE TAKE folder (when the Home Screen
is open).

L1+

Open the MENU > META DATA (for Next
Take) > User Scene Name screen.

Shortcut Explanation

Use to disable the keys set with "Key Hold

— . @ Target".

* During recording, the key does not need
to be used.

L+ Circle the currently selected take.

(Track 1)

Ca+ Open MENU >TIMECODE > Timecode

(Track 2) screen.

L1+

Open the MENU > META DATA (for Next
Take) > Track Name screen.

During recording, the key does not need
to be used.

Open the MENU > INPUT > Trim Link screen.
During recording, the key does not need
to be used.

Open the MENU > META DATA (for Next
Take) > Note screen.

During recording, the (=] key does not need
to be used.

C1+6

Clear the level meter clipping indicators.
During recording, the (=] key does not need
to be used.

L1+

Open the L/R track fader settings screen.
During recording, the key does not need
to be used.

C1+@

Open the MENU > OUTPUT > Headphone >
Headphone Routing screen.

During recording, the (=] key does not need
to be used.
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[ List of shortcuts (continued)

Mixer Screen

Shortcut

Explanation

Press and hold @

Reset the selected pan/fader to the default
value (when the Home Screen mixer is
open). If already set to its default value,
selecting a fader mutes the track.

Character input screen

Shortcut

Explanation

=)
Press and turn @

Move the cursor vertically on a character
input screen keyboard.

Delete a character on the character input

+
=) screen.
+ Move the cursor to "Enter" on the character

input screen keyboard.

Routing screen

Shortcut

Explanation

Press and turn

®

Move the cursor vertically




F8 Multi Track Field Recorder

[ Specifications

)

Recording media

Dual SD card slots support 16MB-2GB SD cards, 4GB-32GB SDHC cards and 64GB-512GB SDXC cards

INPUT 1-8 Connectors XLR/TRS combo jacks (XLR: 2 hot, TRS: TIP hot)
Input gain +10 - +75 dB
Input impedance 3.3kQ

XLR inputs (MIC)

Maximum input level

+14 dBu (at 0 dBFS, limiter ON)

Phantom power

+24/+48V 10mA maximum for each channel

TRS inputs (LINE)

Input gain

-10 — +55 dB

Input impedance

28 kQ

‘3 Maximum input level +24 dBu (at 0 dBFS, limiter ON)
< Eg:;l;/alent input —127 dBu or less (A-weighted, +75dB input gain, 150Q input)
Frequency 10 Hz - 80 kHz +0.5dB/~1dB (192kHz sampling rate)
characteristics
A/D dynamic range | 120 dB typ (-60dBFS input, A-weighted)
Crosstalk —-90 dB or less (between adjacent channels, 1kHz)
MIC IN ZOOM mic capsule input (use disables Inputs 1/2)
SLATE MIC Built-in mic for voice memos can be assigned to tracks freely
Connectors TA-3 connectors, balanced output (2: hot)
Output impedance 150 Q or less
MAIN OUT 1/2 -
Reference output level —-10 dBV (normal output level), —40 dBV (mic output level), 1 kHz, 600Q load
Maximum output level +10 dBV (normal output level), -20 dBV (mic output level), 1 kHz, 600Q load
o Connector 3.5mm stereo mini unbalanced output jack
§_ SUB OUT 1/2 Output impedance 100 Q or less :
8 Reference output level —-10 dBV (normal output level), —40 dBV (mic output level), 1 kHz, 10kQ load
Maximum output level +10 dBV (normal output level), -20 dBV (mic output level), 1 kHz, 10kQ load
Connector 1/4" unbalanced stereo output jack
HEADPHONE Output impedance 15 Q or less

Maximum output level

100mW + 100mW (32Q load)

D/A dynamic range

106 dB typ (-60dBFS input, A-weighted)
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[ Specifications (continued)

Recording formats

When WAV selected

Supported formats

44.1/47.952/48/48.048/88.2/96/192kHz, 16/24-bit, mono/stereo//2-10ch poly, BWF and iXML

Maximum simultaneous
recording tracks

10 (8 inputs + stereo mix)
8 (at 192kHz sampling rate)

When MP3 selected

Supported formats

128/192/320kbps, 44.1/48kHz, ID3v1 tags

Maximum simultaneous
recording tracks

2

Recording time

Using a 32GB card

30:51:00 (48kHz/24-bit stereo WAV)

7:42:00 (192kHz/24-bit stereo WAV)

Connector

BNC

Modes

Off, Int Free Run, Int Record Run, Int RTC Run, Ext,
Ext Auto Rec (audio clock can be synchronized to timecode)

Frame rates

23.976ND, 24ND, 25ND, 29.97ND, 29.97D, 30ND, 30D

Power supplies

Timecode Precision +0.2 ppm
Supported input levels 0.2-5.0Vpp
Input impedance 4.6 kQ
Output level 3.3Vpp
Output impedance 50 Q or less
Batteries: 8 AA

AC adapter: AD-19 DC12V 2A (center plus)

External DC power supply: HIROSE HR10A-7R-4S 4-pin connector (1 pin: -, 4 pin: +), 9-16V




Continuous recording time

When recording 2 channels at 48kHz/16-bit to SD1 with MAIN/SUB OUT OFF, TIME CODE OFF, LED/LCD Brightness 5, 32Q head-

phones, PHANTOM OFF

Alkaline batteries

8.5 hours or more

NiMH (2450mAh)

10 hours or more

Lithium batteries

12.5 hours or more

When recording 8 channels at 48kHz/24-bit to SD1 with MAIN/SUB OUT OFF, TIME CODE OFF, LED/LCD Brightness 5, 32Q head-

phones, PHANTOM OFF

Alkaline batteries

4.5 hours or more

NiMH (2450mAh)

6 hours or more

Lithium batteries

8.5 hours or more

When recording 8 channels at 192kHz/24-bit to SD1 with MAIN/SUB OUT ON, TIME CODE Int Free Run, LED/LCD Brightness 60,

320 headphones, PHANTOM 48V

Alkaline batteries

1 hour or more

NiMH (2450mAh)

2 hours or more

Lithium batteries

3 hours or more

Display 2.4" full-color LCD (320x240)
Mass storage operation
Class | USB 2.0 High Speed
Multi Track audio interface operation (driver required for Windows, not required for Mac)
Class USB 2.0 High Speed
USB Specifications 44.1/48/88.2/96kHz sampling rate, 16/24-bit bit rate, 8 in/4 out

Stereo Mix audio interface operation (no driver required)

Class

USB 2.0 Full Speed

Specifications

44.1/48kHz sampling rate, 16-bit bit rate, 2 in/2 out

Note: iOS device audio interface operation supported (stereo mode only)

Power consumption

12W

External dimensions

Main unit: 7.0 in. (W) x 5.5in. (D) x 2.1 in. (H)

178.2 mm (W) x 140.3 mm (D) x 54.3 mm (H)

Weight (main unit only)

2.1 pounds (960 g)
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For U.S.A.
FCC regulation warning

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

® Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment to an outlet on a circuit different from that to which
the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

FCC CAUTION

Changes or modifications not expressly approved by the party responsible for

compliance could void the user’s authority to operate the equipment.

This transmitter must not be co-located or operated in conjunction with any
other antenna or transmitter.

&

— For EU Countries

‘ € Declaration of Conformity

For U.S.A. and CANADA

This device complies with part 15 of the FCC Rules and Industry Canada license-
exempt RSS standard(s). Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause
undesired operation.

This equipment complies with FCC/IC radiation exposure limits set forth for an

uncontrolled environment and meets the FCC radio frequency (RF) Exposure

Guidelines and RSS-102 of the IC radio frequency (RF) Exposure rules. This

equipment has very low levels of RF energy that are deemed to comply without
testing of specific absorption ratio (SAR).

-

p
For CANADA

Le présent appareil est conforme aux CNR d'Industrie Canada applicables
aux appareils radio exempts de licence. Lexploitation est autorisée aux deux
conditions suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2)
|"utilisateur de |'appareil doit accepter tout brouillage radioélectrique subi,
méme si le brouillage est susceptible d’en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements

énoncées pour un environnement non controlé et respecte les regles

d'exposition aux fréquences radioélectriques (RF) CNR-102 de I'IC. Cet

équipement émet une énergie RF trés faible qui est considérée conforme sans
évaluation du débit d'absorption spécifique (DAS).

.

J

Label is located at the bottom of the unit.
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